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Introduction

ragon NaturallySpeaking let you talk to your computer 
instead of typing. As you talk, your words are transcribed 

onto your screen and into your documents or e-mail messages.

Talking to a computer while it types what you say is called 
dictating. You can dictate, rather than type, into any program 
that accepts text. 

You can use Dragon to:

■ Compose letters, memos, and send e-mail messages—Cut and 
paste inside your documents as well as revise and format text. 
Just think about what you want to say, and then say it into the 
microphone.

■ Enter data into forms or spreadsheets. (Available in 
Professional and higher editions)—Most people can dictate 
numbers faster than they can type. Using Dragon 
Professional or higher editions, you can create custom voice 
commands to let you move from field to field on your form by 
voice. 

■ Work on the Web—Search the Web, access information, and 
navigate Web pages by speaking URLs and links.

■ Start programs and open menus.

■ Use handheld recorders to dictate while you are away from 
your computer. Dragon can then transcribe what you said.

D
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About this guide
This guide covers all editions of Dragon. Most information 
presented applies to all the editions, and the manua notes any 
differences between the editions. 

Conventions used in this guide
1 This guide contains many examples of words and phrases 

you can say when using Dragon. These examples appear in 
italics with quotation marks, for example: “Format That 
Bold.”

2 Some procedures also include sample text for you to dictate. 
Sample text appears in a different typeface, with punctuation 
in square brackets.

3 This guide applies to the all English dialects that ship with 
Dragon: 

■ US English
■ UK English
■ Australian English
■ Indian English
■ Southeast Asian English

US English uses US spelling, punctuation, and time and 
currency formats. We recommend US English for Canadian 
users since this dialect formats numbers (including times, 
telephone numbers, and currency) in North American 
formats.

All other dialects use UK spelling, punctuation, and time and 
currency formats (some number settings depend on your 
Windows Regional Settings). Where multiple dialects are 
used in dictation examples, those dialects appear in a different 
font style. For example:

You can also correct a longer phrase by saying “Correct 
[text] Through [text]” (US/Canada) or “Correct [text] To 
[text]” (Other Dialects). 

4 This guide uses US spelling and punctuation for consistency.
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5 This guide also includes tips and notes to help you use the 
software more effectively. Tips and notes appear like this:

 If you pause correctly, but Dragon still types a command as 
dictation, you can force it to recognize what you say as a command by 
holding down the CTRL key.

With Numbers Mode on, Dragon tries to interpret everything you say 
as a number. If you dictate words, the results will be unpredictable. 
However, you can still navigate menus and switch between programs 
by voice when Numbers Mode is on.

What should I expect from Dragon?

One reason to use Dragon is to boost your productivity. Another 
is to reduce the strain using a computer puts on hands, eyes, 
shoulders, etc. Maybe you like the idea of being able to lean 
back in your chair, put your feet up on the desk, and still get 
work done.

Dragon works by using sophisticated acoustic and statistical 
models; it can quickly adapt to you in various ways, becoming 
familiar with the sound of your voice as well as the particular 
words you use in your dictations. For best results, you should 
develop simple habits such as positioning your microphone 
consistently, dictating punctuation, speaking clearly and evenly, 
pausing briefly before and after voice commands, and taking 
advantage of the easy tools Dragon offers to optimize accuracy: 
for instance, adding to Dragon's vocabulary your own jargon, 
acronyms, phrases or words for which you want a special 
pronunciation or spelling. Dragon lets you import lists of 
vocabulary entries all at once; you can even point Dragon to 
texts that are similar to what you plan to dictate and it will 
quickly "study" them.

Personalizing Dragon's vocabulary is easy, and very important 
for productivity, since it preempts recognition errors. (If a word 
you dictate is not in Dragon's vocabulary, the software cannot 
transcribe it.) Properly correcting Dragon's errors will also help 
it learn. The more you use Dragon, the more opportunities the 
software will have to adapt to you, both in terms of acoustics 
and in terms of language.

NOTE:
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Do I still need my keyboard and mouse?
Although you can use Dragon to do almost everything on your 
computer by voice, some things are still easier to do using the 
mouse or keyboard. 

If using a mouse and keyboard is an option for you, try 
experimenting with using your voice and using your hands for 
different tasks, to see what works best. 

What if I can’t use a keyboard and mouse?
If using a mouse and keyboard is not an option, Chapter 4, 
Working on Your Desktop on page 47.
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2
Installation and User Profile 
Creation

his chapter presents how to install and set up Dragon, and 
then how to train Dragon to understand your voice.

The installation process checks to make sure your system meets 
the minimum system requirements needed for Dragon. These 
system requirements are listed in the information that came with 
your copy of Dragon. 

If your system does not meet these requirements, Dragon will 
not be installed.

Multiple users on one computer
Dragon is licensed on a “per individual” basis. You are 
permitted to install the software on more than one computer 
(such as on a desktop and a laptop computer, or on a work and a 
home computer), but you cannot use the software concurrently 
on more than one computer. You are permitted to create 
multiple voice profiles, so long as each voice profile is for you. If 
someone else wants to create a voice profile, that person must 
purchase a separate Dragon license. 

Volume license agreements are available.

Plugging in the microphone
To use Dragon, you will need to plug in your microphone.

If you are not sure how to plug in your microphone, consult the 
documentation that came with your microphone. 

 If you already have speakers for your computer, you can also 
use these to playback recorded speech instead of your headphones. 

T

NOTE:
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What you should know before installing

Installing Dragon to a custom location
The default installation directory for Dragon is:

C:\Program Files\Nuance\NaturallySpeaking11

During the installation procedure, you can choose to install 
Dragon to a different directory or drive on your machine.

Choosing a different directory during installation only installs 
the Dragon program files to that location. 

Regardless of where you install the Dragon program files, 
Dragon always installs the languages and vocabularies that you 
selected during the installation to the C: drive, as well as 
creating the location where your users profiles will be created. 
These profiles can consume a large amount of disk space on 
your C: drive. For more information on the Dragon installation 
directories, see Version 11 File Structure on page 27.

You can customize your installation to reduce the amount of 
disk space used on your C: drive by not installing unwanted 
languages and vocabularies. For more information, see 
Installing software — Custom Installation on page 10.

Installing on Windows Vista/Windows 7
Dragon Version 11 is compatible with all editions of Windows 
Vista. 

If you upgrade a machine from a previous version of Windows 
to Windows Vista/Windows 7 and that machine has Version 9.x, 
or 10.x of Dragon installed, that version of Dragon will not work 
after upgrading to Windows Vista. All your user profiles from 
these previous versions remain intact and can be upgraded 
when you install Dragon Version 11 or higher. 
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Coexistence with other Dragon products
Coexistence with previous versions of Dragon
You can have only one version of Dragon installed on your 
system. 

 Running Version 9.x or 10.x concurrently with Version 11 is not 
supported.

Coexistence with the Dragon SDK Client Edition
You can install Dragon SDK Client Edition 11 on the same 
machine where Dragon 11 is installed. In addition, Dragon 11 
and Dragon SDK Client Edition 11 can share users and 
vocabularies. 

You can only run one product at a time. For example, if you are 
running Dragon, you cannot run any of the SDK Client tools or 
samples.

 Coexistence of Version 11 with Dragon SDK Client Edition 
Version 9.x or 10.x is not supported.

Before installing the software
Before installing, modifying, or upgrading Dragon:

1 Close all open applications.

2 Turn off or disable antivirus software; the installation process 
can sometimes trigger a false virus report.

 You must have Administrator rights to install or uninstall Dragon 
on Windows XP, Windows Vista, or Windows 7. Administrator rights 
are not required to create a user profile or use the software after 
installation. 

On Windows XP Professional, Windows Vista, and Windows 7 
systems, if as an administrator you want to create a Dragon user profile 
for a Windows limited user (user with restricted privileges), you must log 
on using that Windows limited user account before creating the Dragon 
user profile. 

NOTE:

NOTE:

NOTE:
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If you create a Dragon user profile for a limited user while logged in as 
a Windows administrator, the limited user will not be able to access that 
user profile. These restrictions also apply to an upgrade installation.

3 Choose the type of installation to carry out.

Choosing type of installation
When you install Dragon, you can either do a complete (typical) 
installation or a custom installation. Nuance recommends you 
do a complete installation unless you are experienced with the 
product. The table below tells more about each installation type. 

 If you decide not to install some Dragon components by 
selecting Custom installation, you can install them later by running the 
Setup program again and choosing Modify.

If you are installing the product for multiple users, you should 
choose a Custom installation rather than a Typical/Complete 
installation. To carry out a custom installation, proceed to 
Installing software — Custom Installation on page 10. 

Choose Installation Type

Choose whether to install the entire product or only 
particular features of the product, as explained in the next 
section.

You can also carry out an MSI installation. Refer to the 
online Dragon System Administrator Guide PDF or Help file 
for details.

TYPE DESCRIPTION

Typical/
Complete

Installs all options and speech profiles. Requires the 
maximum disk space.

Custom Lets you select particular options and vocabularies to 
install. Can greatly reduce the disk space required. 
During a custom installation, in the Professional edi-
tion, you can modify settings that are then applied to 
all user profiles created with this installation, including 
Windows limited account users.

NOTE:
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Otherwise, proceed with Installing software — Typical 
Installation on page 9.

Installing software — Typical Installation

To install all features of Dragon:
1 Insert the Dragon DVD into your DVD drive.

If the installation does not start automatically, use Windows 
Explorer to find and double-click setup.exe on the DVD.

 Windows Vista: When you start the installation on Windows 
Vista, you may see the message saying A program needs your 
permission to continue. Click Continue to start the installation.

2 After the Windows Installer begins, it installs two software 
packages if they are not already installed:

■ Visual C++ Version 9.0 Runtime 

3 After the Wizard begins, click Next to proceed to the License 
Agreement page. Read the text and select I accept the terms..., 
then click Next.

4 Enter your User Name and Organization, and the Serial 
Number supplied to your installation. 

5 (Optional) When the Setup Type page appears, click the 
Change button and choose where to install the product.

If no earlier versions of Dragon are installed on your system, 
the default directory is:

C:\Program Files\Nuance\NaturallySpeaking11

For a list of directories created by installation, see Version 11 
File Structure on page 27.

6 While you are still on the Setup Type page, select Typical.

7 profileClick Install to start the installation.

NOTE:
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8 When prompted, click Finish to complete the installation. (If 
you are prompted to restart your computer, restart it now.)

9 Select Start > All Programs > Dragon NaturallySpeaking 11 > 
Dragon NaturallySpeaking 11. The DragonBar appears on 
your desktop.

10(optional) If you have users from Version 9.x or 10.x that 
you would like to upgrade before proceeding, refer to 
Upgrading User Profiles from Versions 9.x and 10.x on page 
26.

11If you have no previously existing users, the Profile Creation 
wizard starts immediately after you run the product. Proceed 
to Creating your user profile on page 16 to set up a user 
profile, then continue as instructed, to train that user profile.

You are now ready to create a user profile, as explained under 
Creating your user profile on page 16.

Installing software — Custom Installation

To install portions of Dragon or to install it for multiple 
user profiles:
1 Insert the Dragon DVD into your DVD drive.

If the installation does not start automatically, use Windows 
Explorer to find and double-click setup.exe on the DVD.

 Windows Vista: When you start the installation on Windows 
Vista, if you see a message saying A program needs your 
permission to continue, click Continue to start the installation.

2 After the Windows Installer begins, it installs two software 
packages if they are not already installed:

■ Visual C++ Version 9.0 Runtime

3 After the Wizard begins click Next to proceed to the License 
Agreement page. Read the text and select I accept the terms..., 
then click Next.

4 Enter your User Name and Organization, and the Serial 
Number supplied to your installation. 

NOTE:
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5 (Optional) When the Setup Type page appears, click the 
Change button and choose where to install the product. 

If no earlier versions of Dragon are installed on your system, 
the default directory is:

C:\Program Files\Nuance\NaturallySpeaking11

For a list of directories created by installation, see Version 11 
File Structure on page 27.

6 While you are still on the Setup Type page, select Custom for 
the type of installation.

 If you decide not to install some Dragon components by 
selecting Custom installation, you can install them later by running the 
Setup program again and choosing Modify.

7 Click Next and you see a tree where you can select any 
particular feature of the product and click the down arrow to 
its left to choose where/when to install it:

■ Install now, on local hard drive
■ Install now, with all subfeatures on local hard drive
■ Install when it is needed on a just-in-time basis

These options are particularly useful for installing multiple 
languages and/or multiple vocabularies.

NOTE:
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For example, see the selections for the Southeast Asian 
English vocabulary shown in the illustration below. 

8 Click Next again and, if you do not have the Professional 
edition, skip to the next step. Otherwise, choose any check 
boxes under Additional options to have additional dialog boxes 
pop up at the end of the installation, where you can make 
changes that affect all users dictating on this computer.

Installing other languages, dialects, and 
specialized vocabularies

To install user files for the other languages or dialects supplied 
with your edition, choose Custom on the Setup Type page. The 
user files for each language or dialect contain both spellings 
and pronunciations specific to that region. For example, users 
who wish to dictate US English spellings—including users with 
accents—should install the US (American) English user files.

OPTION DESCRIPTION

Modify the application’s settings for all users

Displays the Options dialog box at the end of the instal-
lation; here you set several options for all user profiles at 
once (see online Help for details). Useful for an installa-
tion in a shared area; for example, in a conference 
room where multiple professionals could dictate.

Modify the administrative settings
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9 Click Next.

10Click Install to start the installation.

11When the installation completes, proceed with any of the 
following sections that apply to your custom installation:

■ Modifying application settings for all users on page 14 
■ Modifying administrative settings on page 14 
■ Modifying formatting options for all users on page 15 

12When you are prompted to register the product, select one of 
the registration options.

13Click OK to register the product and click it again to proceed.

14Check Yes, check for program updates after the setup completes 
to download any updates after the setup completes and click 
Finish to complete the installation. 

15If you chose to upgrade user profiles earlier, when the 
message about upgrading your user profiles pops up, click 
OK. (The message might tell you that the installation will not 
be complete until after your system is restarted.)

16If you were told you need to reboot in order to complete the 
installation, reboot your computer now.

Displays the Administrative Settings dialog box at the 
end of the installation, where you set up the Roaming 
User feature, where to backup your files, and who can 
modify commands/vocabularies.

Modify the formatting options

Displays Auto-Formatting dialog box at end of installa-
tion, where you apply uniform formatting to all 
documents dictated at this installation; for example, for-
mats for dates, times, and phone numbers. You also set 
whether to expand contractions, apply abbreviations, 
and insert commas automatically. See online Help for 
more details.

OPTION DESCRIPTION
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17Select Start > All Programs > Dragon NaturallySpeaking 11 > 
Dragon NaturallySpeaking 11 or click on the Dragon desktop 
icon.

18If you have users from Version 9.x or 10.x that you would 
like to upgrade before proceeding, refer to Upgrading User 
Profiles from Versions 9.x and 10.x on page 26. Otherwise, if 
you have no previously existing users, the Profile Creation 
wizard starts immediately and you can create a user profile 
as explained under Creating your user profile on page 16.

Modifying application settings for all users
If you checked off Modify the application’s settings for all users 
during a custom installation, the Options dialog box opens 
immediately after the installation completes.

 If you did a typical installation, open the Options dialog box 
by running Dragon and selecting Tools > Options.

In the Options dialog box, you see several tabs you can use to 
set up various aspects of dictating with the product:

For more information on each tab, see the online Help. 

Modifying administrative settings
If you checked Modify the administrative settings during a custom 
installation, the Administrative Settings dialog box opens 
immediately after the installation ends.

 If you did a typical installation, open the Administrative 
Settings dialog box by running Dragon without opening a user and 
selecting Tools > Administrative Settings.

In the Administrative Settings dialog box, you see these tabs:
■ Roaming—To set up roaming users.
■ Miscellaneous—To create backup/distribution directories and 

control who can modify custom commands.

NOTE:

■ Correction
■ Commands
■ View

■ Hot keys
■ Playback/

Text-to-speech

■ Miscellaneous
■ Data

NOTE:
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■ Scheduled Tasks—To schedule voice recognition optimization 
and data collection for improved accuracy, and let users 
modify the schedule.

For details, refer to the Help by clicking the Help button.

Modifying formatting options for all users
If you chose to modify formatting options on the Custom Setup 
page during a custom installation, the Auto-Formatting dialog box 
opens after the installation completes.

 If you did not do a custom installation, to set up formatting: Run 
Dragon, open a user, and select Tools > Formatting.

The Auto-Formatting dialog box for all versions of Dragon 
NaturallySpeaking appears as shown below.

NOTE:

Choose the 
options to 
apply to your 
dictated 
documents.
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Creating your user profile
Before you can begin using Dragon, you must let Dragon create 
a user profile for each person who is dictating.

Your user profile stores acoustic information about your voice 
that Dragon uses to recognize what you say. This profile also 
stores any changes you make to the standard vocabulary—any 
special words, names, acronyms, and abbreviations you add. 

When you launch the software for the first time, the Profile 
Creation wizard starts and leads you through creating your user 
profile:

 If you upgraded a single user from an earlier version, Dragon 
opens that user’s profile. If you upgraded multiple users, it displays 
profiles for all upgraded users in the Open User dialog box. 

To create a user profile:
1 In the Creating a user profile page, click Next in the lower 

right corner to proceed.

2 Proceed through the wizard, filling in the information it 
requests and clicking Next to proceed. 

NOTE:
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When the wizard asks for your name, you can enter your 
first name only, a nickname, or your first and last name.

The wizard asks for your age to help Dragon work with 
vocal differences it associates with different age ranges. 

The wizard also asks for region of the world you live in to 
help Dragon interpret your speech based on regional 
differences.

3 When the Help Dragon understand how your pronounce words 
page appears, select your accent.

The accents you can choose from are:

■ Standard—Select if your accent is not covered by another 
choice or your are not sure which accent to select.

■ Australian accented English 
■ British accented English 
■ Indian accented English
■ Inland Northern US (Great Lakes area)—Upstate New 

York through the Chicago area
■ SEAsian accented English—South East Asian
■ Southern US—Most of Southern United States, including 

Texas
■ Spanish accented English

Determining your own accent can be difficult. For example, 
say you grew up in one part of the United States but have 
lived long enough in another part to lessen your original 
regional accent. If you have any doubt about picking an 
accent, select Standard and allow Dragon to learn your 
accent. 

If you do not select a specific accent (in other words, you 
select the Standard accent), you may want to perform 
Acoustic Optimization after using the product for several 
hours. Acoustic Optimization updates your user profile with 
accumulated acoustic data from any corrections and 
additional training you may have done. Running Acoustic 
Optimization will increase your overall accuracy. In the 
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process of increasing your accuracy, Acoustic Optimization 
may select a different accent for you.

If you select a specific accent, Acoustic Optimization will still 
increase your overall accuracy, but will not change your 
accent. Once you have selected a specific accent for a user, 
you cannot change it later.

Dragon Version 11 lets you create and train users in multiple 
languages. If you have purchased an edition with support for 
more than one language, you can add languages by later 
choosing Custom during the installation and having the 
Dragon DVD available to install the language files during the 
process of creating user profiles.

4 When the How do you talk to your computer? page appears, 
select your type of microphone from the list of Microphones. If 
you record your speech using a recording device, select a 
recorder from the list of Recorders.

5 In the Review your choices page, be sure the information is 
correct before you proceed. 

6 Dragon automatically chooses a speech model to use as the 
foundation for your individual user profile. It also selects the 
vocabulary it uses to recognize words correctly based not 
only on their sound, but also on their context. However, if 
you want to select a particular speech model and vocabulary, 
you can click the Advanced button and in the Choose models 
page select a:

■ Speech model from the drop-down list for Speech model. 
Dragon uses the speech model to adapt to your voice 
during training. Dragon automatically recommends the 
type of speech model and vocabulary that is appropriate for 
your computer’s speed/memory. Usually, you should follow 
Dragon’s recommendation

■ Type of vocabulary from the Vocabulary type list:

■ Medium—Requires at least 512 MB of RAM.

■ Large—Requires at least 1 GB of RAM.
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■ Empty Dictation—(Professional edition only) Vocabulary 
with a language model but without any words, designed 
for experienced users or resellers who want to create 
highly specialized vocabularies. 

7 Click OK to save your selections in the Choose models page 
and return to the Profile Creation wizard.

8 Click the Create button in the lower right corner of the page 
to create your user profile.

When Dragon finishes creating your user profile, it takes you 
through the next part of the process. Proceed to Setting up/
positioning your microphone on page 19.

Setting up/positioning your microphone 
When Dragon finishes creating your user profile, it displays the 
Position your microphone properly page, where it begins to lead 
you through the process of setting up your microphone.

Following the wizard’s instructions, position your microphone .

Positioning the microphone correctly is important. If the 
microphone is out of place, Dragon might not be able to hear 
you clearly and make mistakes.

Consistent positioning is also important. Make sure that you 
position the microphone the same way each time you dictate.

Here are some tips on using particular types of microphones:

Using a headset microphone
■ Position the microphone about a half-inch (approximately 

the width of your thumb) from your mouth and a little off 
to the side. The microphone should not touch your mouth, 
but it can be almost touching your lips.

■ If you need to move the microphone out of the way, lift the 
“boom” up and over your head, rather than bending it out 
of position or removing the headset.

Using a handheld microphone
■ Hold the microphone one to three inches from your mouth 

and a little off to the side.
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■ If the volume display on the DragonBarTM turns red, try 
holding the microphone slightly farther from your mouth. 

Using an array microphone
■ Position the array 18 to 30 inches from/pointed at your 

mouth. 
■ Avoid blocking the path between your mouth and the 

array, for example by holding a book or paper in front of 
your face. 

■ Avoid having any source of noise or signal other than your 
voice directly facing the array within at least 15 feet. 

9 After you have positioned the microphone, click Next to 
continue with Checking microphone volume/sound quality 
on page 20.

Checking microphone volume/sound quality
After you have positioned the microphone and clicked Next, you 
see the Dragon will adjust your volume page. 

1 Click the Start Volume Check button and then read aloud 
the text displayed in the box. 

2 When the program beeps to indicate it has finished checking 
the volume, click Next.

3 When the Dragon will test the quality of your sound system 
page appears, click Start Quality Check and then read aloud 
the text displayed in the box. 

4 The program beeps when it has finished evaluating the sound 
quality of your system. If Dragon displays Passed, click Next 
to continue. 

 Windows Vista or XP: If you get a Sound level is too 
low error while creating a Dragon user profile, to boost the 
microphone’s volume:

1. Select Start > Control Panel > Sound and Audio Devices. 

2. On the Voice tab, click the Volume... button under Voice 
recording to open the Recording Control dialog box.

3. Set the volume level for the appropriate input device type.

NOTE:
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5 Continue with Training a new user profile on page 21. 

Training a new user profile

Immediately after you create your profile, before you begin 
dictating, you train Dragon to understand your voice.

Performing training either during or after creating a user profile 
enhances your recognition accuracy. In initial training you read 
aloud for several minutes from one of the available texts.

 For information on training a mobile user, see the online help.

If you skipped training earlier to open a user profile, from the 
DragonBar menu, select Profile > Open User Profile and select 
your name in the list; then click Open to proceed. Since you have 
not completed training, options for Training appear. 

To train a new user:
1 When the Read text aloud to train Dragon page of the 

wizard appears, choose from these training options:

■ Show text with prompting
■ Show text without prompting
■ Skip training (not recommended)

2 In the Read Training Text page of the wizard, click Go.

3 If you chose the first training option (Show text with 
prompting):

■ A yellow arrow showing you where to start reading 
appears. 

■ Click Go and begin reading the text. To take breaks while 
you’re training the program, click Pause.

 To advance through the first two screens, you must say the 
sentences without pausing. For the rest of the screens, it’s okay to pause 
in the middle of a sentence.

■ When the words change color, it means the computer has 
heard and recognized them. 

NOTE:

NOTE:
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■ If you need to re-read the same words, click Redo, then re-
read them. If the computer still doesn’t get it, just click 
Skip. Otherwise, click Next to continue. 

4 If you chose the second training option (Show text without 
prompting):

■ In the Read Training Text page, under Choosing text to read, 
choose a text to read aloud and click Next. 

■ When the Text Display page appears, choose how you want 
to read the text, from the screen or from a printed page. If 
you choose to read from a printed page, click Print to print 
the text. 

■ Click Next to continue.
■ If you chose to read the text from the screen, the Speaking 

to the computer page appears and advises you to position 
your microphone. 

■ After you position your microphone, click Train to begin.
■ In the Speaking to the Computer popup, click Begin Training 

and read the text in the box. 
■ Click Next page to proceed from page to page.

5 When the list pops up, choose a text to read aloud and click 
OK. 

You need to read for only about 5 minutes to train Dragon to 
recognize your voice.

You can take breaks during this training by clicking Pause. 
Don’t worry if you make mistakes or laugh. You should try to 
read exactly what you see on the screen, but it’s okay if you 
read something incorrectly. The computer either ignores the 
mistake or positions the yellow arrow at the beginning of the 
text for you to reread it.

The progress bar shows how much text is left to dictate. 

 During training, dictating punctuation is not necessary. 

6 When you’ve read enough, the Training wizard displays a 
congratulations message. Click OK and Dragon starts 
adapting to your voice. 

NOTE:
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7 Proceed to Adapting to your writing style, scheduling tuning 
on page 23.

Adapting to your writing style, scheduling tuning
After it adapts to your voice, Dragon’s Accuracy wizard appears 
and prompts you to first adapt Dragon to your writing style, 
then schedule regular Acoustic and Language Model tuning, 
and optionally schedule Data Collection. 

Adapting to your writing style (Let Dragon search for 
words and add them now)

Dragon can analyze your writing style to increase your overall 
recognition accuracy. This tool scans documents in your My 
Documents directory—Microsoft Word, Corel WordPerfect, text 
files, html files, and rich text files (.rtf).

Adapting to your writing style can add 5 to 30 minutes to user 
training. Close all other programs when you run this step.

 Though we recommend that you run this part of the New User 
Wizard, if you plan to skip this step, select Skip this step rather than 
Cancel.

1 In the Let Dragon search for words and add them now page 
of the Accuracy wizard, to have Dragon search for words 
and phrases you use in your email messages, select the Sent 
E-mails check box. To have Dragon search your word 
processing and text files, select the My Documents check box. 

2 Click Start to initiate the search for words. While scanning 
your files, the dialog box displays the process’s status. When 
Dragon finishes searching, it displays a message telling you to 
click Next to continue and proceed with Let Dragon 
automatically improve your accuracy on page 24.

NOTE:
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Let Dragon automatically improve your accuracy
After it adapts to your writing style, the Accuracy wizard gives 
you the option of setting up a schedule to automatically run 
Acoustic and Language Model tuning processes:

 Acoustic and Language Model tuning processes add commonly 
used word sequences the user dictates as well as acoustic data from 
any corrections and additional training the user executes. Scheduling 
tuning processes helps Dragon learn from you and makes your dictation 
more accurate.

1 In the Let Dragon automatically improve your accuracy 
page, to have Dragon periodically tune your user profile to 
improve your accuracy, be sure to check the Automatically 
improve accuracy check box. If you do not change the 
schedules, by default Dragon initiates Acoustic tuning every 
Monday at 2 AM and Language Model tuning every day at 3 
AM.

2 If you want to have Dragon tune your user profile at a 
different time or more or less often, click the Change 
Schedule button and, in the Select Time and Frequency 
dialog box, set the schedules on both the Acoustics and 
Language Model tabs. The schedules do not have to be the 
same. As a rule, you should try to run these processes when 
you are not dictating and run the Language Model tuning 
more often.

3 Be sure that you check the Enable check box on both the 
Acoustics and Language Model tabs or the tuning processes 
occur on the default schedule, rather than the schedule you 
set.

4 Click Next to continue. 

Scheduling data collection (Help us improve Dragon)
After it lets you set the schedule for accuracy tuning, the 
Accuracy wizard lets you set whether or not to collect data and 
schedule when it should be collected:

 When you set Data Collection to run, it collects up to 500 MB of 
acoustic data and text from your dictation sessions. Once the data is 
collected, you have the option of sending it to Nuance to help improve 

NOTE:

NOTE:
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the accuracy of future versions of Dragon. No personal information is 
ever sent to Nuance and participation in data collection is completely 
voluntary. 

1 In the Help us improve Dragon page, you can choose:

■ Run Data Collection
■ Don’t run Data Collection but remind about this later
■ Don’t run Data Collection

2 If you choose Run Data Collection, click Change Schedule 
and set what time and how often the data is sent to Nuance 
in the Select Time and Frequency dialog box (Daily, Weekly 
or Monthly). If you do collect data, by default Dragon 
initiates the process every Wednesday at 12:30 AM.

3 Be sure that you check the Enable check box in the Select 
Time and Frequency dialog box or the collected data is sent 
to Nuance on the default schedule, rather than on the 
schedule you set.

4 Click Next to continue. 

5 When the Congratulations, your profile is ready to use page 
appears, you can now:

■ Choose to run the tutorial.
■ Learn about the many improvements in Version 11 .
■ Modify how Dragon presents itself to you.
■ Begin dictating. 

6 Click Finish to close the wizard.

To upgrade existing user profiles before dictating, proceed to 
Upgrading User Profiles from Versions 9.x and 10.x on page 26. 

Or to begin dictating, proceed to the next chapter, Starting to 
Dictate on page 31.

How Dragon automatically configures user profile
After you create a user, Dragon automatically analyzes your 
hardware and changes the default settings of your users to 
optimize performance. 
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Depending on your hardware, you might receive a message that 
the amount of RAM (memory) on your computer is relatively 
low for the operating system. When you use Dragon on such a 
computer, try not to have more than one or two applications 
open. 

Upgrading User Profiles from Versions 9.x and 10.x
If you chose to upgrade existing users during the installation, the 
User Upgrade Wizard appears the first time you run Version 11. 

 If you do not want to upgrade users right now, you can exit from 
the wizard and do it later.

Otherwise, you can start the User Upgrade Wizard from the 
Windows Start menu at any time.

To upgrade existing 
users:
1 To start the User 

Upgrade Wizard, 
select Start > All 
Programs > Dragon 
NaturallySpeaking 
11.0 > Dragon 
NaturallySpeaking 
Tools > Upgrade 
Users. The User 
Upgrade Wizard 
appears.

2 On the Select Users to Upgrade page, modify the list of users to 
include users that you want to upgrade. The wizard starts by 
including all users in the current folder as candidates to 
upgrade. You add users to the list by clicking the Add button 
and browsing for additional users in other locations. You 
remove users from the list by selecting them and clicking the 
Remove button. After the list contains only the users you 
want to upgrade, click Next.

3 Click Next and choose the location for the upgraded user 
profiles. As the User Upgrade Wizard modifies your user files 

NOTE:
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to work with the newest version, it can place the upgraded 
user in another location while keeping the old files 
untouched, in case you need them again.

4 Click the Browse button in the Choose Destination page of the 
wizard to select the location for the upgraded user profiles. If 
you do not set a location, Dragon places the profiles in the 
default location (see Version 11 File Structure on page 27).

5 (Optional) If you want to make changes to the user locations, 
base vocabularies, and/or acoustic models, click the 
Advanced button and the Advanced Options dialog box opens.

In this dialog box, you can make finer adjustments to how 
the wizard upgrades particular users. You see a list of the 
users being upgraded. For each user you see the user name, 
old location, vocabulary, and one or more acoustic models.

When you click on the location line of a user in the list, the 
New Location text box below the list becomes available. You 
can click Browse and select a new location.

When you click on the vocabulary line of a user in the list, the 
New Base Vocabulary text box below the list becomes 
available. You can choose a new base vocabulary from the 
drop-down list.

When you click on the acoustic model line of a user in the list, 
the New Acoustic Model text box below the list becomes 
available. You can choose a new combination language, 
language model, and accent from the drop-down list.

6 Click OK to return to the wizard.

7 Click Next to proceed to the Upgrade Users page where you 
click Begin to begin the upgrade process. Expect to wait 
approximately 5 minutes for each user being upgraded.

8 When the upgrade process is complete, click Finish. 

Version 11 File Structure

 File locations shown apply to installations in the default location.NOTE:
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The next two sections tell you where Dragon places files on 
your computer. The locations vary, depending on your operating 
system.

Windows XP Pro/XP Home/Windows Server 2003/2008 
directory structure

Dragon Program directory
You can specify this location during the installation.

C:\Program Files\Nuance\NaturallySpeaking11
\Ereg
\Help
\Program
\Tutorial (optional)

Data and user directories
You cannot change this location—Dragon always installs these 
directories to your \Document and Settings directory.

C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking11\ 
\Data
\Data\Training
\results
Roaming Users
\Users

C:\Documents and Settings\<username>\Application 
Data\Nuance\NaturallySpeaking11\Results

Windows Vista and Windows 7 directory structure
Dragon Program directory
You can specify this location during the installation.

C:\Program Files\Nuance\NaturallySpeaking11
\Ereg
\Help
\Program
\Tutorial (optional)

Data and user directories
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You cannot change this location—Dragon always installs these 
directories to your \Document and Settings directory.

C:\ProgramData\Nuance\NaturallySpeaking11\ 
\Data
\Data\Training
\results
Roaming Users
\Users

C:\Users\<username>\AppData\Roaming\Nuance\
NaturallySpeaking11\Results

Cleaning up after uninstalling
The following files remain on your machine after you uninstall:

Dragon installs these files for Microsoft SAPI4 support. You do 
not need these files if you do not have other speech applications 
that require SAPI4. If you do have applications that require 
SAPI4 support, you might need to re-install those applications if 
you remove these files.

Accessing log files, samples, and tools
You can open log files and samples from the desktop:

■ NaturallySpeaking log file (dragon.log)—Select Start > 
Programs > Dragon NaturallySpeaking 11.0 > Show Dragon Log.

■ NaturallySpeaking setup files (dgnsetup.log)—Select Start > 
Programs > Dragon NaturallySpeaking 11.0 > Show Setup Log.

■ Structured command samples—Select Start > Programs > 
Dragon NaturallySpeaking 11.0 > MyCommands Samples. 
(Professional edition only)

\Windows\Speech\ 
VText.dll 
Vdict.dll
WrapSAPI.dll 
XTel.Dll
Xcommand.dll 

Xlisten.dll 
Xvoice.dll 
spchtel.dll 
speech.cnt 
speech.dll 

speech.hlp 
vcauto.tlb 
vcmd.exe 
vcmshl.dll 
vtxtauto.tlb
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■ Tools—Select Start > All Programs > Dragon 
NaturallySpeaking 11.0 > Dragon NaturallySpeaking Tools. 
(Professional edition only) 
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3
Starting to Dictate

ow that you’ve installed the software and completed 
training, you’re ready to dictate your first sentence.

Starting Dragon
If Dragon NaturallySpeaking is not already running, you can 
start it by:

 You can start Dragon over a Remote Desktop connection 
(Windows XP Professional and Windows XP Home), but interactive 
dictation is not supported. Using a Remote Desktop connection, you can 
access the DragonBar and transcribe dictation but you cannot use a 
microphone attached to the remote machine to dictate.

■ Double-clicking the Dragon icon on the 
desktop.

■ Selecting Start > Programs > Dragon 
NaturallySpeaking 11.0 > Dragon NaturallySpeaking 
11.0.

■ If the QuickStart option is enabled, right-clicking the 
QuickStart taskbar tray icon and selecting Start 
Dragon. For more on using the QuickStart option, see 
Using QuickStart on page 44. 

N

NOTE:
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Turning on the microphone
Before you can dictate, you need to turn on the microphone. To 
turn on the microphone, you:

■ Click the microphone 
icon on the DragonBar. 
You can click this icon 
again to turn it off.

■ Press the plus (+) key on 
the numeric keypad to 
turn the microphone on, 
and then press it again to turn the microphone off.

■ Click the microphone icon in the Windows task bar.

The button and the volume meter on the DragonBar change to 
show if the microphone is off or on.

 Once the microphone is off, you cannot turn it on again by 
voice.

Sleeping and waking up
To make Dragon stop listening temporarily:

1 Say “Go to Sleep” or “Stop Listening.” Then Dragon 
ignores everything except the “Wake Up” or “Listen To Me” 
commands.

2 To reactivate the microphone, say “Wake Up” or “Listen To 
Me.”

You can also press the numeric plus (+) key to turn on/off the 
microphone.

Shows that the microphone is 
off

Shows that the microphone is 
on

Microphone icon

NOTE:
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Starting to dictate
To begin dictating, start a word processor (such as Microsoft® 
Word or Corel® WordPerfect®) and begin a new document. 
Make sure your text insertion point is at the start of the new 
document. 

 Remember to click in the window you want to talk to before you 
speak.

Start talking. 

As you speak, Dragon 11 indicates that it is processing by 
displaying a small Dragon logo at your insertion point, and 
when you pause, your dictated words appear in your document. 
Our research shows that this enables many users to dictate 
better, without being distracted by seeing the preliminary results 
accumulating in the Results Box, as in previous versions. The 
traditional Results Box is still available from the View tab of the 
Options dialog box. (From What’s new)

Don’t worry about mistakes at this point; Dragon improves as 
you use it.

Using Natural Punctuation
Dragon can automatically add periods and commas at the 
appropriate places in your dictation without you having to 
explicitly speak that punctuation. The Natural Punctuation 
feature can be useful in helping you get used to dictation by 
focusing on what you are saying rather than how your speech is 
punctuated. 

Natural Punctuation inserts only periods and commas. You 
have to dictate other punctuation marks. Even with Natural 
Punctuation turned on, you can still dictate periods and 
commas. As you become more adept at dictation and want more 

DragonPad

You can use the DragonPad, a simple word processor 
included with Dragon. To open the DragonPad, from the 
Tools menu on the DragonBar, click DragonPad.

TIP:
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control over where punctuation appears, you may want to 
explicitly dictate all your punctuation.

 You can turn Natural Punctuation on and off by voice by saying 
"autopunctuation on" and "autopunctuation off" or by selecting Tools > 
Auto-Formatting Options from the menu of the DragonBar and 
clicking Automatically add commas and periods.

For more information on Natural Punctuation see Using 
Natural Punctuation on page 111.

Dictating punctuation
You can dictate punctuation at any time while you are using 
Dragon, even when Natural Punctuation is enabled. 

Use the following list as a guide to dictating the most common 
punctuation marks. (For a complete list of punctuation, see the 
online help.)

Starting new lines and paragraph
While you are dictating, you can use the following commands to 
duplicate the action of pressing the ENTER key once (to add a 
new line) or twice (to add a new paragraph).

TO ENTER SAY (US/Canada) SAY (Other Dialec ts )

, comma comma

. period full stop

! exclamation point or 
exclamation mark

exclamation mark

? question mark question mark

- hyphen hyphen

: colon colon

TO SAY 

Add a new line “New Line” 

Add a new 
paragraph

“New 
Paragraph” 

NOTE:
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Saying "New Paragraph" presses the ENTER key twice and capitalizes 
the next word you dictate.

Tips for dictating text
■ To erase the last thing you said, say “Scratch That.”

■ You can repeat “Scratch That” to undo a sequence of 
phrases. 

■ To undo the effects of a command, say “Undo That.” If 
“Undo That” fails to undo an action, try repeating the 
command until you completely undo the operation.

■ To stop a recognition in progress (and turn the microphone 
off), click the small red button inside the Results Box. 

■ You can change the very last phrase you spoke by saying 
“Bold That,” “Cap That,” “Correct That,” and so on; you 
do not have to select the text first. 

■ To remove a trailing space after a word, you can say “Delete 
Previous Character.” 

■ You can create a spoken form for words you prefer not to say 
aloud. For example, you can create a command that types 
“Snookums” whenever you say “Mary's nickname.” 

■ To clear (deselect) your last selection, say “Unselect That.” 

For information on correcting any mistakes, see Chapter 5, 
Correcting and Editing on page 69. 

Using the Dictation Box
Normally you can dictate and use Dragon voice commands in 
any text window of any application. However, you may 
occasionally find an application or a specific window in an 
application where some voice commands won’t work or won’t 
work consistently. 

In these situations, you can use a special window, called the 
Dictation Box. You use the Dictation Box to dictate and edit text 
in these non-standard windows without the difficulties you 
might otherwise experience. 
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To start the Dictation Box:

1 Place you cursor where you want to put the text.

2 Start the Dictation Box by either: 

■ Saying “Show Dictation Box”
■ Select Tools > Dictation Box from the DragonBar 
■ Use CTRL + SHIFT + D 

3 When the Dictation Box displays, you can dictate and edit text 
inside the Dictation Box using all Dragon commands. 

4 Once you are done dictating and editing the text, say or click 
“Transfer.” The text you dictated in the Dictation Box is 
transferred to the application. 

For more information on using the Dictation Box with a non-
standard window, see the online help.

Printing and saving your dictated text
Printing
From the File menu of your word processor, use the mouse to 
choose Print. Or say “Click File,” pause, and say “Print.” You 
can also simply say “Print Document” or “Print File” if the 
Natural Language Commands are enabled. See the online help 
for more information.

Saving
From the File menu, choose Save. You can also say “Click 
File” and then say “Save.” Remember, you have to pause 
between the “Click File” and the “Save” commands to have 
Dragon recognize them as two separate commands. If the 
Natural Language Commands have been enabled, you can say 
“Save Document.”

Getting Help
To access the online Help for Dragon, click the Help menu on 
the DragonBar and choose Help Topics. 

Alternatively, you can say “Give Me Help.” 
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You can print individual Help topics with the Print button in the 
Help window. To open the online Help links, just say their 
names. The links display next to the application window and 
give you examples of the most common commands that work in 
the application you are currently using. 

The online help includes the following information not found in 
this user guide:

■ Creating and Managing Users
■ Dictation Guidelines
■ Dictating using a Portable Recorder
■ Dictating with a Roaming User
■ Correcting Recognition Errors
■ Revising Text
■ Improving Recognition Accuracy
■ Working on Your Desktop
■ Working in Programs
■ Creating Commands with MyCommands 
■ Dragon Tools

“What Can I Say?”
Saying “What Can I Say?” brings up the Dragon Sidebar with 
Dragon Tips displaying below it. The Dragon Sidebar displays a 
selection of useful commands that Dragon recognizes for the 
current context, whether it is a particular program you are using 
or the Windows desktop.

To open the Dragon Sidebar:
1 Choose Dragon Sidebar from the Help menu on the 

DragonBar or say either “What can I say” or “Show 
SideBar.”



Starting to Dictate

38

2 The Dragon Sidebar opens, displaying a selection of 
commands next to the window you are working in.

 Commands marked with an asterisk (*) are available only if you 
selected the Enable Natural Language Commands check box on the 
Commands tab of the Options dialog box. 

3 To see commands for the Windows Desktop, click on the 
desktop and watch the commands in the Dragon Sidebar 
change.

The contents of the Dragon Sidebar change
depending on the application that is active.

For example, when you switch between
Microsoft Outlook and the DragonBar,

the contents of the Dragon Sidebar
change accordingly.

DragonBar
commands

MS Outlook
commands

NOTE:
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 A list of Global commands (available everywhere) appears if 
there are no Dragon commands available for the active program. 

4 To see additional commands for the current program, click 
the Mouse or MyCommands tab along the top of the Dragon 
Sidebar. Or click one of the icons to the upper right (see next 
illustration) to open:

■ Command Browser
■ Vocabulary Editor
■ Options dialog box
■ Dragon Help

NOTE:

Global
commands

Windows Desktop commands
available on the desktop and Global
commands available in all windows.

Desktop
commands
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5 For more information, see the online help.

Tutorial
To start the Tutorial, choose Tutorial from the Help menu on the 
DragonBar. The Tutorial includes a number of lessons covering 
the basics of Dragon.

Troubleshooting
If you are having problems using Dragon, or if you are getting 
unexpected results, please refer to the Resolving Problems and 
Tips sections of the online help.

The DragonBar

The DragonBarTM gives you access to Dragon functions and 
features.

Command
Browser

Vocabulary
Editor Options  

dialog box
Dragon
Help

Icons to the top far right
on Sidebar open various 
functions inside Dragon.}

MyCommands

Mouse
Commands

Microphone

Menus

Status Extras

Volume Display
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Microphone button and volume display
When the microphone is on, the 
Volume Display shows the sound 
level:
■Yellow means silence or that you 
are speaking too softly.
■Green means that you are 
speaking at a proper level

■ Red means that you are speaking too loudly.

The Full Text Control indicator
The DragonBar includes a Full Text Control indicator that turns 
green when you are in an application or window where all of 
Dragon’s functionality is supported. 

Normally you can dictate and use Dragon voice commands in 
any text window of any application. However, you may 
occasionally find an application or a particular window in an 
application where some voice commands won’t work or won’t 
work consistently. 

When you are in a non-standard window, the Full Text Control 
indicator goes out, indicating that you may have some difficulty 
selecting and editing dictated text. 

Also, when you start dictating into a non-standard window, the 
DragonBar will display Dictating into a non-standard window.

If you have difficulty in dictating or correcting in one of these 
non-standard windows, use the Dictation Box. See the online 
help for more information on using the Dictation Box.

Volume display

Full Text Control indicator (looks like check mark) 
displays in green to show that you can dictate.
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Extras toolbar 
If the button is in your edition of Dragon, you can click the 
Extras button  on the far right of the DragonBar to open the 
Extras toolbar. The Extras toolbar displays buttons for 
transcribing hand-held recorder audio and playing back your 
dictation. 

Correction
Clicking the Correction button opens the Correction menu to 
teach the computer what you said. See Chapter 5, Correcting 
and Editing on page 69.

Transcribe 
Use this button to transcribe your speech from a handheld 
recorder. See the online help for more information.

Start Playback and Stop Playback 
When you select text and click the Start Playback button, you 
hear a recording of your dictation. A yellow arrow displays on 
your screen during playback, following what you said. Click the 
Stop Playback button to stop the recorded speech playback.

Read That
When you select text and click the Read That button, Dragon 
reads the text to you.

Skip Back and Skip Forward
Use these buttons to skip backward or forward one utterance. 
To Dragon, an utterance is a group of words said together 
without pausing. 

You can display the Extras menu items in the main DragonBar. 
See the online help for more information.

Start 
Playback

Stop
Playback Skip

Forward

Correction
Button

Skip
Back

Transcribe
Button

Read 
That
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Changing the DragonBar position
To change the position of the DragonBar, click the Dragon icon 
at the far left of the DragonBar. A menu displays that lets you 
move the DragonBar to various positions on your display:

 You can also hide the DragonBar by saying “Switch to Tray 
Icon Only Mode.” To make a hidden DragonBar reappear, right-click 
on the small microphone in the lower right corner of the screen. From 
the menu that appears, click Restore Previous DragonBar Mode.

Controlling Dragon with voice commands
You can operate Dragon with voice commands. For example, to 
show the Extras toolbar, say “Show Extras Bar.” For a list of 
other voice commands that control Dragon, see Controlling the 
DragonBar in the online help.

SELECT.. .  TO.. .

Docked to Top 
(default) mode

lock the DragonBar to the top of the screen.

Docked to Bottom 
mode

lock the DragonBar to the bottom of the 
screen.

Floating mode freely position the DragonBar.

Cling mode make the DragonBar appear just above the 
window you are dictating into.

Tray Icon Only mode hide the DragonBar completely and display 
the Microphone icon only in the Windows 
task bar.

NOTE:
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Using QuickStart
The Dragon QuickStart taskbar tray icon gives you quick access 
to Dragon and recent users. Right-clicking the QuickStart icon 
displays the QuickStart menu.

 This option is installed at the end of Dragon setup process. 

When in QuickStart mode, Dragon launches automatically at 
system startup time and adds the Dragon icon to the Windows 
taskbar.

To enable QuickStart:
Two ways to enable QuickStart mode are:

■ During Custom installation. If during the installation you 
choose to set Dragon options, when the installation is 
complete.

■ By clicking the Dragon icon in the upper left corner of the 
DragonBar and selecting Tray Icon Only Mode. See Using 
QuickStart on page 45 for more information.

To shut off/permanently disable QuickStart:
1 In the DragonBar menu, select Tools > Options and click the 

Miscellaneous tab of the Options dialog box.

2 De-select Launch in QuickStart mode on Windows startup.

To Redisplay the DragonBar:
To display the DragonBar while the product is running in 
QuickStart mode, right-click on the microphone icon in the 
QuickStart taskbar tray and select Restore Previous DragonBar 
Mode.

To Temporarily Disable QuickStart:
To temporarily disable QuickStart, right-click the QuickStart 
taskbar tray icon and select Exit. This action exists Dragon and 
removes the QuickStart tray icon from the Windows taskbar. 
When you re-start Windows, the QuickStart taskbar tray icon 
re-displays. 

NOTE:
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Using QuickStart
You access QuickStart by right-clicking the Dragon QuickStart 
taskbar tray icon. This action displays QuickStart menus that 
parallel the menus in the DragonBar.

If the QuickStart icon becomes unavailable for any reason, you 
can always start Dragon from the Windows Start menu.

SELECT.. . TO.. .

Turn Dragon’s Micro-
phone On/Off

Turn on or off the microphone.

Profile > Take any action you would otherwise takefrom the Profile menu. Add 
an audio source; add a vocabulary; open, close, save, ,manage. back-
up or restore a user profile.

Tools > Open any option from the Tools menu.

Vocabulary > Open any option from the Vocabulary menu.

Modes > Open any option from the Modes menu.

Audio > Open any option from the Audio menu.

Help > Open any option from the Help menu.

Close DragonBar Shut down Dragon if it is currently running.
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4
Working on Your Desktop 

his chapter describes how to control almost everything on 
your computer with Dragon NaturallySpeaking voice 

commands. 

Programs, documents, and folders
Using voice commands, you can start programs and open 
documents and folders that appear in your Start menu or 
desktop. 

You can’t start Dragon by voice. However, you can have 
Dragon automatically start in Sleep mode whenever you start 
Windows by selecting Microphone on (asleep) option in the 
Miscellaneous tab of the Options dialog box. See the online help 
for more information.

Starting a program
To start a program from the Start menu, say “Start” and then 
the name of the program exactly as it appears on the menu or 
submenu of the Start menu. You can also say the name 
displayed below the icon on your desktop. 

For example, to start Microsoft® Internet Explorer®, say “Start 
Internet Explorer.” 

Shorter names for popular programs
From start_and_exit_programs

For the popular Windows programs listed here, you can use 
shorter program names in addition to the standard program 
label shown on the Start menu or under the program icon on the 
Desktop. For other programs you'll need to say the standard 
program label. 

T
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■ MS Word, Microsoft Word, Microsoft Office Word 

■ MS Excel, Microsoft Excel 

■ MS Outlook, Microsoft Outlook 

■ Outlook Express 

■ MS PowerPoint, Microsoft PowerPoint 

■ MS Access, Microsoft Access 

■ MS InfoPath, Microsoft InfoPath 

■ Internet Explorer, Microsoft Internet Explorer 

■ Firefox, Mozilla Firefox 

■ Corel WordPerfect, WordPerfect 

■ Acrobat Reader 

■ Lotus Notes 

Opening documents and folders from the Start menu
To open a document or folder from the Start menu, say “Start” 
and then the name of the document or folder exactly as it 
appears on the menu.

For example, to open a document named sales.doc, you could 
say “Start Sales dot doc.” To open a document named 
journal.wpd, you could say “Start journal dot w p d.”

To open a document or folder from your Windows® desktop, just 
say “Start” and then the name below the icon. For example, to 
open a folder named Projects, say “Start Projects.”

Switching between open windows
You can switch between the windows you have open by saying 
“Switch to” and then say the name of the program or document 
window exactly as it appears in the title bar. 

Say “Start Projects” 
to open the folder.
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For example, if Microsoft® Word® is running, you can switch to 
it by saying “Switch to Microsoft word.” 

You can also switch between open windows by saying “Switch 
to Previous Window” (same as pressing ALT+TAB) and 
“Switch to Next Window” (same as pressing 
ALT+SHIFT+TAB).

From list_apps_dlg

To switch between open programs or windows
To list all open programs: Say "List Programs" or "List all 
windows." The List of Open Applications window opens.

To list open windows of multi-document applications: Say "List 
windows for <program name>" For example, say "List windows 
for Microsoft Word" The List of Windows opens. 

To switch to an open program or window: Say "Choose n," 
where n is the number of the program or window you want to 
switch to, or just say the number next to the word. For example, 
say "Choose 2" or "2"

OR

Choose the number of the program or window from the list and 
click OK. 

SAY THIS TO 

Switch to Next 
Window

Switch to the next application.

Switch to Previous 
Window

Switch to the previous application.

Switch to Microsoft 
Word

Make Microsoft® Word the active 
application.

Switch to (name of 
application)

Switch to the open application you say. 
Say the name of the application as it 
appears in the title bar of the application 
window.
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Opening and closing menus 
You can activate any menu by saying the menu name.

To open a menu:
1 Open a program window (for example, Microsoft® Word) and 

make it active.

Say the name of the menu you want to open (for example, say 
“File”). If the command does not work, try saying “Click” and 
then the name of the menu you want to open (for example, say 
“Click File”). 

2 In this example, the File menu should open. If the command 
doesn’t work (for example, if the word “click” is typed into 
your document), you may have paused in the middle of the 
command.

3 Say the name of a menu item to activate it (for example, say 
“Save”).

4 To close a menu, say “Cancel.”

 To open the Start menu, say “Click Start” or “Click Start Menu.”

 If commands are often typed into your document instead of 
recognized as commands, you can make Dragon recognize commands 
only when they are preceded by saying “Click.” To do this, select the 
Require “Click” to select menus and controls check box on the 
Commands tab of the Options dialog box. For more information, 
see the online help.

Say “File” or
“Click File”

Say “Save”

TIP:

NOTE:
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Selecting buttons, tabs, and options
When Dragon is running, you can select any button, check box, 
text box, or other dialog box option you see by saying its name. 
If that doesn’t work, say “Click” and then its name.

For example, to select a check box labeled Toolbar, say 
“Toolbar” or “Click Toolbar.” To clear the check box (deselect 
it), say its name again. 

You can select tabs by saying the name of the tab, alone or 
preceded by “Click.” In the dialog box pictured, you could say 
“Options” or “Click Options” to select the Options tab. You can 
also move between tabs by saying “Go to Next Tab” and “Go to 
Previous Tab.”

 In some programs, you may not be able to select dialog box 
items by saying their names. If this happens, the following method of 
selecting items may work: say “Tab Key” repeatedly to move to the item 
you want, then say “Press Space Bar” to select it.

See also Moving the mouse pointer and clicking the mouse on 
page 63.

Say “Wrap to
window” or

“Click Wrap
to window”

Say “Toolbar” or
“Click Toolbar” to
select check box.

NOTE:
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Using Windows Desktop commands

You can use voice commands to perform many actions on the 
Windows Desktop, as shown in the table below.

TO DO THIS YOU CAN SAY

Open Windows special folders 

Open your My Computer 
window

"Open My Computer"

Open your My Documents 
folder

"Open My Documents"

Open your My Pictures 
folder

"Open My Pictures"

Open your My Music folder "Open My Music"

Open your My Videos folder "Open My Videos"

Start applications and utilities 

Start a program by name "Open <program name>"

Open Windows Explorer "Open Windows Explorer"

Open Windows Help and 
Support Center

"Open Windows Help"

Open the Windows Task 
Manager

"Open Task Manager"

Open the Windows Run dia-
log box

"Open Run dialog"
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Open the Windows System 
Configuration Utility 
(msconfig)

"Open System Configuration Utility"

Open the Windows Control 
Panel

"Open Control Panel"

Open the Windows Print 
Manager

"Open Print Manager"

Add a printer to your Win-
dows system

"Add a new printer"

Add or remove programs to 
your Windows system

"Open Add or Remove Programs window"

Change the Windows Dis-
play Settings

"Change Display Settings"

Change the Windows screen 
resolution 

"Change screen resolution"

Change Windows Power 
Settings

"Change power settings"

Navigate between windows 

Switch between windows  "Choose n," where n is the number of the 
window you want to switch to. For example, 
say "Choose 2"
OR
"Switch to previous window" 
OR 
"Switch to next window."
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Selecting icons on the desktop
You can use voice commands to select icons on the Windows® 
desktop.

To select an icon on the desktop:
1 Switch to the Windows® desktop. To do this by voice, 

minimize all open applications and place the mouse pointer 
over the desktop icon. Say “Mouse Click” to make the 
desktop active.

Switch to a specific program 
or document

"Switch to <program name>" For example, 
say "Switch to Microsoft Word"
OR
"Switch to <document name>"
OR
 "List windows for <program name>" 

Work with windows 

Enlarge the active window to 
the size of your monitor's 
screen

"Maximize window"

Minimize the active window "Minimize window" 

Close the active window "Close window"

Minimize all windows and 
display the Windows 
Desktop

"Show Desktop"
"Minimize [all] windows"

Return a maximized window 
to its original size

"Restore window"

Restore all minimized 
windows

"Restore [all] windows"
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2 Say the name of the icon (for example, “My Computer”). 
Dragon types the icon name and Windows® selects it.

3 To select another icon, say “Move” and then the direction 
(up, down, left, right) and number of icons (up to 20). 

For example:

Say “Move Right 1,” “Move Down 2,” or “Move Up 3.”

After you select an icon, you can say “Press Enter” to start or 
open the program and “Press Shift F10” to display its right-
click menu (as if you had right-clicked the icon with the mouse).

You can also use voice commands for these actions. See 
Marking and dragging objects on page 65.

Resizing and closing windows
To resize and close windows, say “Click” and then one of the 
following window commands:

SAY THIS TO 

Click Minimize or
Click Control Menu 
(pause) Minimize

Minimize the active window.

Click Maximize or
Click Control Menu 
(pause) Maximize

Maximize the active window.

Say “Move Down 2”
to select Recycle Bin

Say “My Computer”
to select the My
Computer icon
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 “Click” is required for the Control menu commands.

 If you have trouble getting Dragon to recognize any of the window 
commands, you can first open the Control menu by saying “Click 
Control Menu,” then say the command. 

Scrolling in popular programs
You can use the following commands in many programs to 
scroll and move the view through the program's work area. 

These voice scrolling commands work with Microsoft Office 
2003 and 2007 programs, including Word, Outlook, Excel, 
PowerPoint, and InfoPath.

From scroll_in_programs

Click Restore or
Click Control Menu 
(pause) Restore

Restore window to previous size.

Click Close or
Press ALT F4

Close the active program.

Press CTRL F4 Close the active document, not the 
whole program (works in many 
programs).

Click Start Menu or
Click Start or
Press CTRL ESC

Open the Windows® Start Menu.

TO SAY

Start automatic upward scrolling "Start Scrolling Up"

Start automatic downward scrolling "Start Scrolling 
Down"

Stop automatic scrolling "Stop Scrolling"

Increase the speed of automatic scrolling "Scroll Faster"

SAY THIS TO 

NOTE:

TIP:
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Scrolling in windows and list boxes
You can scroll vertically in a window (for example, an online 
Help window) or list box by saying “Move Down” and “Move 
Up” and then a number of scroll bar arrow clicks (up to 20). 
For example, say “Move Down 4” or “Move Up 10.” 

You can scroll horizontally by saying “Move Left” and “Move 
Right” and then a number of scroll bar arrow clicks (up to 20). 
For example, say “Move Left 10” or “Move Right 5.” 

Opening lists and making selections
You can activate any list box by saying the list box name.

To open a list box:
1 Say the name of the list box you want to open.

2 Say “Show Choices,” “Drop List,” or “Open List.” The list 
box opens to show all the choices available in the list.

To make a selection from an open list:
1 Say the full name of the selection. 

2 Say “Move Down” or “Move Up” and the number of places 
your selection is from the current selection. 

Reduce the speed of automatic scrolling "Scroll Slower"

Move the visible page up one line "Scroll Up"

Move the visible page down one line "Scroll Down"

Move up one line in the text "Line Up"

Move down one line in the text "Line Down"

Move the page up by a screen "Page Up"

Move the page down by a screen "Page Down"
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Pressing keyboard keys
You can activate Windows® menus and controls by pressing 
keys. With Dragon you can “press” any key on your keyboard 
by voice. You can press letters, numbers, modifier keys (SHIFT, 
CTRL, and ALT), and so on. 

You can say “Press,” “Press Key,” or “Type”—all three voice 
commands work the same way.

 “Scratch That” will not erase keystrokes dictated with the Press 
Key commands. You must select the text by voice or mouse and delete it 
or say “Press Delete.”

Pressing letters
You can press any letter on your keyboard by saying “Press” 
and then the letter. When you’re pressing letters, you must say 
“Press” before each one. For example, to enter “txt,” say 
“Press t,” “Press x,” “Press t,” pausing between letters.

 You can also spell words using Spell mode. See Switching 
recognition modes on page 119 for more information.

For similar-sounding letters (such as B, D, and V), you can use 
the International Communications Alphabet to spell the letter 
keys, for example, “Press alpha” or “Press bravo” or say 
“Press d as in David” or “Press d for David,” and so on) as if 
you were spelling to another person over the phone.

SAY THEN  

Press a

b

any letter a–z or any international 
alphabet word alpha through zulu

a as in Albert/Alice/alpha

b as in Bill/Buffalo/bravo

c as in Cathy/Carl/Charlie

d as in David/daughter/delta

e as in Edgar/enter/echo

NOTE:

TIP:
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 You can say “Press c” or “Press Charlie” but you cannot say 
“Press Cathy” or “Press Carl.”

Capitalizing a letter
You can capitalize a letter by saying “Press Cap,” then the 
letter. 

f as in Frank/fancy/foxtrot

g as in George/gopher/golf

h as in Henry/helmet/hotel

i as in Iris/Ireland/India

j as in John/justice/Juliet

k as in Karen/kitchen/kilo

l as in Larry/lemon/lima

m as in Mickey/magic/Mike

n as in Nancy/nobody/November

o as in Otto/over/Oscar

p as in Paul/people/papa

q as in Quentin/question/Quebec

r as in Robert/Rachel/Romeo

s as in Sam/Singapore/sierra

t as in Terry/Tyler/tango

u as in Ursula/unit/uniform

v as in Valerie/visit/Victor

w as in Wendy/wake/whiskey

x as in Xavier/Xerxes/xray

y as in Yolanda/Yvonne/yankee

z as in Zachary/zookeeper/zulu

(you can also say “for” instead of “as in”)

SAY THEN  

NOTE:
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For example, to enter “28K” say “twenty eight” and then 
“Press Cap K” (or “Press Cap K for Karen”).

Pressing numbers
You can press numbers (0 to 9) by saying “Press” and then the 
number. For example, say “Press 8.” 

Pressing key combinations
When you’re pressing keys, you can press any combination of 
the modifier keys (SHIFT, CTRL, and ALT) at the same time as 
another key, such as a letter. For example, you can say:
■ “Press Control Z” (undoes last action)
■ “Press Alt F” (opens File menu)

■ “Press Shift Tab” (moves backward through dialog box 
options)

 Dragon ignores the command “Press Control Alt Delete” (the 
keyboard shortcut for restarting a computer).
NOTE:
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Pressing function and numeric keypad keys
To press a function key (F1 to F12), say “Press Function” and 
then the name of the key. For example, say “Press Function 1” 
to bring up the online Help.

To press the keys on the numeric keypad, say “Press Keypad” 
and then the name of the key. For example, you can say “Press 
Keypad Minus” to press the keyboard shortcut that opens the 
Correction menu. See the complete list below: 

 Num Lock must be on for the “Press Keypad” commands to 
work. You can say “Press Num Lock” to turn Num Lock on.

SAY THEN

Press Keypad 1 

Keypad 9 (you can say any number from 
0 to 9) 

All Dialects: Keypad Point (.) 
US/Canada: Keypad Period (.) 
Other Dialects: Keypad Full Stop (.) 

Keypad Slash (/) 

Keypad Asterisk (*) 

Keypad Minus (-) (opens the Correction 
menu)

Keypad Plus (+) (turns the microphone on or 
off) 

Keypad Star (*) (opens the Dragon menu on 
the DragonBar) 

Keypad Enter 

NOTE:
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Pressing other keys
Here’s a list of other keys you can press by voice:

SAY THEN 

Press Up Arrow 

Down Arrow 

Right Arrow 

Left Arrow 

Home Key 

End Key 

Page Up 

Page Down 

Insert Key 

Delete Key 

Control Key 

Shift Key 

Alt Key 

Print Screen

Scroll Lock

Pause Key

Num Lock

Caps Lock
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Moving the mouse pointer and clicking the mouse
Dragon provides hands-free mouse control with MouseGrid and 
the mouse motion voice commands. You can use these features 
to position the mouse pointer anywhere on the screen, click the 
mouse buttons, and drag objects—all by voice.

Moving the mouse pointer with MouseGrid
You can position the mouse pointer anywhere on the screen by 
using MouseGrid. You can move the pointer relative to the full 
screen or the active window.

To use MouseGrid:
1 Say “MouseGrid” to place the MouseGrid over the full 

screen (as shown below) or say “MouseGrid Window” to 
place it over the active window. For example: 

2 Say a grid number from 1 to 9 to position the pointer in that 
numbered area. In this example, to position the pointer over 
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the Recycle Bin, say “4.” A smaller MouseGrid will appear 
in the chosen grid square. 

3 To zoom in over the desired area, say another grid number. 
In this example, say “4” to place the pointer over the Recycle 
Bin icon.

4 Continue to say the respective grid number to zoom in until 
the mouse pointer is over an icon or other object. You can 
use voice commands to click the mouse or mark and drag the 
object. See the following sections for instructions.

 You can undo the last MouseGrid action by saying “Undo 
That.”

To close MouseGrid, say “Cancel.” 

Moving the pointer with the Mouse command
You can move the mouse pointer up, down, left, or right a short 
distance (a few millimeters) by using the mouse pointer 
commands.

You can combine moving the mouse pointer and clicking the 
mouse in a single voice command. For example, you can say 
“Mouse Up 3 Click” or “Mouse Right 2 Double Click.” 

Say “4” to place
a smaller

MouseGrid over
grid square
number 4.

TIP:
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To move the pointer:
1 Say “Mouse” followed by the direction and number of times 

to move it (up to 10). For example, say “Mouse Up 5” or 
“Mouse Left 10.” 

2 When the pointer is over an icon or other object, you can use 
voice commands to click the mouse or mark and drag the 
object.

Clicking the mouse
You can click, double-click, left-click, and right-click the mouse 
buttons by voice.

To click the mouse:
1 Position the mouse pointer over the object you want to select 

(for example, say “MouseGrid 9 1” or “Mouse 2”).

2 Say “Mouse Click,” “Mouse Double Click,” “Mouse Left 
Click,” or “Mouse Right Click.”

When an object is selected, you can mark and drag the object 
(as described in the next section).

Marking and dragging objects
You can mark an object and drag it to a different location by 
voice. 

To mark and drag an object:
1 Position the mouse over the icon or object you want to drag 

and then say “Mark” (for example, say “MouseGrid 9 1 
Mark”).

2 Move the mouse pointer to where you want to drag the object 
and then say “Drag” (for example, say “MouseGrid 6 3 
Drag”).

 Instead of “Drag,” you can also say “Control Drag” and “Shift 
Drag” to drag while holding down the CTRL or SHIFT key.
TIP:
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Dragging the mouse
You can use the following movement commands if you select the 
Enable mouse motion commands check box on the Commands 
tab of the Options dialog box.

Moving the pointer with the mouse motion commands
In addition to the mouse movement methods described above, 
you can also move the mouse by using the mouse motion 
commands. Say, for example, “Move Mouse Right.” The mouse 
pointer begins moving to the right and keeps moving until you 
say “Stop.”

SAY THEN A 

DIRECTION

THEN A SPEED 

(OPTIONAL)

"Drag Mouse" (to move) "Up" "Faster"

 "Mouse Drag" (to move) "Down" "Very Fast"

"Control Mouse Drag" (to 
copy)
or 
"Control Drag Mouse"

"Right" "Much Faster"

"Left" "Slower"

"Upper Right" "Very Slow"

"Upper Left" "Much Slower"

"Lower Right"

"Lower Left"
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Enabling the mouse motion commands
To use the mouse motion commands:

1 From the Tools menu on the DragonBar, choose Options and 
then the Commands tab.

2 Select Enable mouse motion commands and click OK. 

3 Click the Speed button to choose how fast the mouse pointer 
moves when you use a mouse motion command.

The mouse motion commands
Here is a summary of the available mouse motion commands.

While the mouse is moving, you can say any of the commands 
above. You can also say: 

■ “Stop” or “Cancel” to stop the mouse from moving

■ “Up,” “Down,” “Left,” “Right,” “Upper Left,” “Lower 
Left,” “Upper Right,” or “Lower Right” to change the 
direction in which the mouse is moving

■ “Faster,” “Much Faster,” “Slower,” or “Much Slower” to 
change the speed at which the mouse is moving

■ “Click,” “Double Click,” “Right Click,” or “Left Click” to 
click the mouse buttons

■ “Go to Sleep,” “Stop Listening,” or “Microphone Off” to turn 
the microphone off

To specify which mouse button (left, right, or center) is being 
held down during mouse drags or if you want the SHIFT, CTRL, 

SAY THEN A DIRECTION THEN A SPEED (OPTIONAL)

Move Mouse
Mouse Move
Drag Mouse
Mouse Drag

Up
Down
Right
Left
Upper Left
Lower Left
Upper Right
Lower Right

Fast
Faster
Much Faster
Very Fast
Slow
Slower
Much Slower
Very Slow
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or ALT key held down during the mouse drag, use one of these 
commands before saying one of the drag commands in the 
preceding table:

For example, to drag with the SHIFT key held down, you could 
say “Shift Mouse Drag Up.” To drag with the right ALT key 
held down (the ALT key on the right side of the keyboard), you 
could say “Right Alt Drag Mouse Upper Left.”

■ Left

■ Middle (requires 
three-button 
mouse)

■ Right

■ Shift

■ Control

■ Alt

■ Right Shift

■ Right Control

■ Right Alt
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5
Correcting and Editing

hen Dragon NaturallySpeaking types the wrong words, 
you should correct these mistakes. By giving the program 

the right word, you actually teach the program not to make the 
same mistakes again. 

Correcting mistakes requires some extra effort, but it saves you 
time in the long run by making Dragon more accurate. You’ll 
probably need to correct mistakes often when you first start 
dictating, and then less frequently as the program learns from 
your corrections.

Make it a habit to correct mistakes to continue to improve the 
accuracy of the program. Make sure you save your speech files 
when prompted, to preserve the adjustments the program 
makes.

 You must select a word before typing over it. Using the backspace 
key and retyping (or saying “Scratch That”) will not enable the software 
to learn from corrections and improve recognition accuracy. For 
accuracy to improve, you must first select text and then correct it or 
overwrite it with the words you said.

Correcting mistakes
There are a number of ways you can correct the 
misrecognitions in a document. The following techniques 
describe the most basic methods, but you can combine these 
techniques in any manner that suits your working style.

To correct text with the keyboard:
1 Move the insertion point to the beginning of the dictation you 

want to correct. 

2 Press the correction hot key to display the Correction menu. 
By default, this is the minus (–) key on the numeric keypad. 

W

TIP:
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You can change the hot key assignment on the Hot keys tab of 
the Options dialog box. You can also click the Correction 
button on the Extras toolbar of the DragonBar. 

3 If one of the alternatives is correct, press the Down Arrow key 
to highlight that choice and then press ENTER to accept it. If 
no alternative is correct, just type or say the correct text. 

4 Continue until all the text is correct. 

Correcting text using voice commands 
1 Say “Select” or “Correct” and the text that is incorrect, the 

Correction menu appears with a number of alternatives. 

■ If one alternative is correct, say “Choose” and the number 
of that alternative. 

■ If none of the alternatives is correct, say “Spell That,” 
spell the correct word or words into the Spell dialog box, 
and then say “OK.” 

Selecting a large amount of text or an entire document and 
then saying “Spell That” can produce unpredictable results.

2 Verify that the correct text appears in the document in place 
of the misrecognized text and continue to the next 
misrecognition. 

Correcting text while playing back dictation
1 Move the insertion point to the beginning of the dictation you 

want to correct. 

2 Click Play That Back on the Sound menu of the DragonBar or 
click the Start Playback button on the Extras toolbar. You 
can also say, “Play that back.”

3 When the playback of your dictation reaches a recognition 
error, press the correction hot key. By default, this is the 
minus (–) key on the numeric keypad.

4 If one of the alternatives is correct, press the Down Arrow key 
to highlight that choice and then press ENTER to accept it. If 
no alternative is correct, just type or say the correct text and 
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press the Correction hot key again. Playback continues 
automatically from the point where you stopped. 

5 Continue until all the text is correct. 

Using the Correction menu
The Correction menu shows Dragon’s best guess of the 
alternatives to the words you dictated and selected. 

To correct a word or phrase with the Correction menu:

1 When you notice a mistake, pause in your dictation, and then 
say "Select" and the incorrect word or phrase. If the error is 
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in the last thing you said, you can just say "Select That." 
Dragon highlights the word or phrase, and the Correction 
menu appears.

2 If the correct word or phrase is on the list, start spelling to 
choose it, or say "Choose" and the number of that choice. For 
example, say "Choose 2." Do not say "Choose Numeral Two" 
or Dragon will transcribe the phrase as the text "Choose 
Numeral Two" or "Choose 2" depending on how you set the 
number formatting options on the Auto-formatting dialog 
box. 

3 If the word or phrase you want is not on the list, spell the 
word, or say "Spell That," or just say the word again. 

correction_dialog_items

The Correction menu contains the items listed below. You can 
choose them by voice, mouse, or using the down arrow and 
pressing Enter.

Numbered list of alternative recognitions
Lists alternatives to what Dragon thinks it heard. If one 
alternative is correct, say "Choose" and the number of that 
alternative. For example, "Choose Two." 

Do not say "Choose Numeral Two" or Dragon will transcribe 
the phrase as the text "Choose Numeral Two" or "Choose 2" 
depending on how you set the number formatting options on the 
Auto-formatting dialog box.

Spell That
Saying "Spell That" opens the Spelling window, where you can 
enter the correct word or phrase by spelling it or typing it. Use 
the Spelling window to play back a segment of dictation, modify 
an alternative that is almost correct, or provide acoustic training 
so that Dragon better "hears" the difference between what you 
said and what it had originally transcribed. 

Note that if you enter a word in the Spelling window that is 
unknown to Dragon, Dragon adds the word to its Vocabulary.
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Play That Back
Plays back recorded dictation of the selected word or phrase.

All Caps That
Capitalizes the initial letter in the selected word or words.

Add that to Vocabulary
Displays the "Add Individual Word" dialog so you can add the 
selected word or phrase to the vocabulary. Adding the word or 
phrase will help Dragon recognize it in the future.

Unselect That
Deselects the selected word or words. 

Don't Recognize That Word
Removes the selected word from your active Vocabulary, so that 
Dragon won't recognize it again. This can save you time if 
Dragon repeatedly replaces words you dictate with words you 
don't use. 

For example, if you dictate the name "Cassity" often and 
Dragon always hears "Cassidy," you could use Don't Recognize 
That Word from the Correction menu to turn off recognition of 
Cassidy. If you decide later that you do need to use the word, 
you can add it back using the Vocabulary Editor.

Make That a Command
Displays the MyCommands Editor to make the currently 
selected word or phrase a Dragon Command. With this option, 
you can associate up to 70 characters of dictation that you reuse 
frequently with a single command. That way, you don't need to 
retype it or retrieve it from a file location on your computer 
when you want to reuse it. 

Correction Options
Opens the Correction tab of the Dragon Options dialog box 
where you can modify the behavior of the Correction menu and 
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specify which command is used to bring it up, "Correct" or 
"Select."

Correcting Punctuation
Note the following when correcting punctuation:

■ When you select a phrase (more than one word) that has 
punctuation, be sure to dictate that punctuation. For example, 
say you initially dictated, “Today is Thursday I have a 
meeting at 11 o’clock” and the text was transcribed as “Today 
is Thursday, I have a meeting at 11 o’clock.” If you want to 
change the comma to a period, say “Select Thursday 
comma.” If the correct punctuation appears in the Correction 
menu, select it. Otherwise, you can dictate over the selection 
by, for example, saying “Thursday period.”

■ When you select punctuation, the Correction menu might list 
alternate punctuation 

■ If Natural Punctuation is turned on, when you select a phrase 
that Dragon has added punctuation to, the choices will include 
punctuation changes . 

 When you select a word that has adjacent punctuation the 
Natural Punctuation feature added, the selection will extend to include 
that punctuation.

Selecting text by voice

Using Full Text Control®

You can revise your dictation without correcting it by selecting 
the text using the “Select” command and then saying new 
words to replace the selected text. 

To use Full Text Control®:
1 Dictate the sentence below:

US/Canada: “Let’s meet for lunch on Tuesday [period]”

Other Dialects: “Let’s meet for lunch on Tuesday [full stop]”

NOTE:
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2 Say “Select lunch on Tuesday.” The words lunch on Tuesday 
should be highlighted on the screen.

3 Say “dinner on Wednesday.” These words should replace 
lunch on Tuesday. 

Since “Tuesday” and “Wednesday” sound completely different, 
Dragon will know you are not correcting a recognition mistake 
but rather revising your dictated text. 

 You can also select punctuation marks.

4 Say: “Select period” (US/Canada) or “Select full stop” 
(Other Dialects). If there’s more than one period or full stop, 
you can say “Select Again” to select a different one.

5 To replace the period or full stop with an exclamation mark, 
say “exclamation mark.” 

 It is often easier for Dragon to find the matching text if you select a 
short phrase rather than individual words. If you select some words that 
are already correct, just say them again along with the ones you want 
to change.

Selecting the same text again 
If the words you’re trying to select appear more than once on 
the screen and Dragon selects the wrong ones, just say “Select 
Again.” The program then looks for another instance of the 
same word or words.

You can also say “Select Again” if Dragon selects a word that 
sounds like the word you want, but is not the correct one (for 
example, “two” instead of “too”).

Unselecting words 
If the wrong text is selected, say “Unselect That.” 

You can also unselect words by moving your insertion point (by 
mouse or voice) to another part of your document. For example, 
say “Go to End of Line” or click somewhere else in your 
document. 

TIP:

TIP:
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Selecting a longer phrase 
You can select a longer phrase by saying “Select [text] Through 
[text]” (US/Canada) or “Select [text] To [text]” (Other Dialects). 
For [text], substitute the actual word or words at the beginning 
and the end of the range of wrong words. For example, you 
could correct the underlined words in the following sentence:

With a little practice, who will develop a habit of dictating an 
unclear, steady voice, and the computer will understand you 
better.

by saying:

(US/Canada) “Select who Through unclear” or “Select who 
will Through an unclear”

(Other Dialects) “Select who To unclear” or “Select who will To 
an unclear”

Then dictate the correct text:

“you will develop the habit of dictating in a clear”

The final corrected sentence reads:

With a little practice, you will develop the habit of dictating in 
a clear, steady voice, and the computer will understand you 
better.

 If you’re correcting more than one word, the words must all be in 
sequence (next to each other). You can’t use a single command to 
correct words that are in different parts of your document.

Selecting your whole document 
To select all the text in your document, say “Select Document” 
or “Select All.” This command is useful when you want to 
change the font or the way text is aligned.

When you want to copy all the text in a document to another 
window, the easiest way to do it is with the “Copy All to 
Clipboard” command. 

 When a lot of text is selected, the “Scratch That” and “Cut That” 
commands don’t work, nor can you overwrite the selection by dictating 
new text. This prevents you from accidentally deleting a large part of 

NOTE:

NOTE:
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your document. To remove a large selection, you can say “Delete That” 
instead.

Selecting an entire paragraph or line 
You can select the current paragraph by saying “Select 
Paragraph.” To select the current line, say “Select Line.”

You can also select a number of paragraphs or lines (up to 20). 
For example, you can say “Select Previous 5 Paragraphs.”  

Selecting a word or character  
You can select the current word by saying “Select Word.” To 
select a character, say “Select Next Character” or “Select 
Previous Character.” 

You can also select a number of words or characters (up to 20). 
For example, say “Select Previous 2 Words.”  

SAY THEN THEN

Select Next Paragraph

Previous 2...20 
Paragraphs

Forward Line

Back 2.20 Lines

Last

SAY THEN THEN

Select Next Word

Previous 2...20 Words

Forward Character

Back 2...20 
Characters

Last
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Moving around in a document 
When you’re editing a document, you can move around in it by 
voice. After you place the insertion point where you want it, you 
can dictate more text, select text, copy and paste, or apply 
formatting.

Going to the top or bottom of a page or document 
You can move to the top or bottom of the current page by saying 
“Page Up” (equivalent to pressing the PAGE UP key) or “Page 
Down” (equivalent to pressing the PAGE DOWN key).

You can move to the top or bottom of your document by saying 
“Go to Top” or “Go to Bottom.”

Going to the beginning or end of a line 
You can move to the beginning or end of the current line by 
saying “Go to Beginning of Line” or “Go to End of Line.”  

SAY THEN

Go to Top

Move to Bottom

Top of Document

Beginning of Document

Start of Document

Bottom of Document

End of Document

SAY THEN

Go to Beginning of Line

Move to Start of Line

End of Line
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Placing the insertion point before or after a specific word 
You can place the insertion point before a specific word by 
saying “Insert Before” and then the word or words. You can 
place the insertion point after a word by saying “Insert After” 
and then the word or words.

After you move the insertion point where you want it, you can 
dictate more text, paste text, add punctuation, and so on.

To place the insertion point before a specific word:
To move the insertion point before the word lets in the sentence 
below, say “Insert Before lets” (or “Insert Before lets me 
talk”). Remember not to pause between any of the words:

Dragon lets me talk instead of type.

To place the insertion point after a specific word:
To move the insertion point after the word “talk” in the sentence 
below, say “Insert After talk” (or “Insert After lets me talk”).

Dragon lets me talk  instead of type.

Moving up or down a paragraph or line 
You can move up or down a paragraph by saying “Move Up a 
Paragraph” or “Move Down a Paragraph.” You can also 
move up and down a number of paragraphs (up to 20). For 
example, you can say “Move Up 3 Paragraphs.”

You can move up or down a line by saying “Move Up a Line” 
or “Move Down a Line.” You can also move up and down a 
number of lines (up to 20). For example, you can say “Move 
Down 3 Lines,” as delineated in the table below:

SAY THEN THEN

Move Up a Paragraph or 1 
Paragraph

Back 2...20 Paragraphs

Down a Line or 1 Line

Forward 2...20 Lines
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Moving right or left a word or character 
You can move to the right or left of a word by saying “Move 
Right a Word” or “Move Left a Word.” You can also move right 
or left a number of words (up to 20). For example, you can say 
“Move Right 3 Words.” 

You can move to the next or previous character by saying 
“Move Right a Character” or “Move Left a Character.” You 
can also move forward and backward a number of characters 
(up to 20). For example, you can say “Move Left 4 Characters” 
or “Move Back 6 Characters,” as delineated in the next table:

Copying, cutting, and pasting text
You can move text from one place to another by using the “Copy 
That,” “Cut That,” and “Paste That” commands. 

To copy, cut, or paste text:
1 Select the text you want to copy or cut.

2 Say “Copy That” or “Cut That.”

3 Move the insertion point to where you want to paste the text.

4 Say “Paste That.”

Deleting text

Deleting the last words you dictated 
You can erase the last words you dictated by saying “Scratch 
That.” When you say this command, Dragon deletes the last 

SAY THEN THEN

Move Right a Word or 1 Word

Forward 2...20 Words

Left a Character or 1 Character

Back 2...20 Characters
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thing it typed into your document. This may be a full sentence, a 
phrase, or just one word, if that’s all you said before pausing.

You can say “Scratch That” up to 10 times to delete the last few 
things you said. If you repeat the command, you must pause 
before saying it again. You can also say, for example, “Scratch 
That 5 Times.”

Going back as you dictate 
When you’re dictating, sometimes you may hesitate or think of a 
better way to say something right after you’ve said it. When this 
happens, you can use the “Resume With” command to return to 
where you were before the mistake.

Just say “Resume With” followed immediately by the word or 
words to which you want to return. Then, continue dictating. 
Any text after the new position of the insertion point will be 
replaced with your new dictation.

 When using the “Resume With” command, remember not to 
pause in the middle. Say “Resume With” and then immediately say the 
words to which you want to return. These words must be in the last three 
or four sentences (100 characters) you said; you can’t use “Resume 
With” to return to an earlier part of your document.

To go back as you dictate:
1 Suppose you dictate this sentence: “I have a deadline this 

week, but we could meet for lunch… um… er… next 
Wednesday.”

2 To correct the sentence, return to the last correct words you 
remember dictating. For example, say “Resume With meet 
for lunch.” (Remember not to pause in the middle.)

3 Then, dictate the rest of the sentence. For example, say “next 
Wednesday at noon.”

Deleting specific words 
You can delete text by selecting it and saying “Delete That.” 

To delete text:
1 Select the text you want to delete.

NOTE:
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2 Say “Delete That.” 

You can also say “Scratch That” to do the same thing.

Deleting the next or previous paragraph or line 
You can delete the next or previous paragraph by saying “Delete 
Next Paragraph” or “Delete Previous Paragraph.” You can 
delete the next or previous line by saying “Delete Next Line” or 
“Delete Previous Line.” 

You can also delete a number of paragraphs or lines (up to 20). 
For example, you can say “Delete Previous 5 Paragraphs.” 
See the complete list below: 

Deleting the next or previous word or character 
You can delete the next or previous word by saying “Delete 
Next Word” or “Delete Previous Word.” You can delete the 
next or previous character by saying “Delete Next Character” 
or “Delete Previous Character.” 

You can also delete a number of words or characters (up to 20). 
For example, you can say “Delete Previous 5 Words.” See the 
complete list below: 

SAY THEN THEN

Delete Next Paragraph

Previous 2...20 Paragraphs

Forward Line

Back 2...20 Lines

Last

SAY THEN THEN

Delete Next Word

Forward 2...20 Words

Previous Character

Back 2...20 Characters
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 Another way to delete the previous character is by saying 
“Backspace.” This is equivalent to pressing the BACKSPACE key. You 
can “press” it multiple times (up to 20) by saying, for example, 
“Backspace 5.”

Spelling as you dictate
With the Spell command in Dragon, you can easily spell a word 
or phrase you want to dictate into your document. This can be 
useful if you are dictating a word that is not likely to be in the 
Dragon vocabulary, such as a proprietary term, a proper name, 
or a non-English word. Say, for example, “Spell b-u-o-n space 
g-i-o-r-n-o.” The word you spelled appears right in your 
document. 

You must say “Cap” if the word contains a capital letter. For 
example, say “Spell Cap R-u-m-p-e-l-s-t-i-l-s-k-i-n” to type 
“Rumpelstilskin.”

Last 2...20 Characters
SAY THEN THEN

NOTE:
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If you say “Spell” by itself, without any letters after it, the Spell 
dialog box opens.

You can then speak the letters and Dragon will type them or you 
can correct any errors in the word you spelled.

When spelling, you can say numbers and special characters as 
well as letters. For example, to dictate an automobile license 
plate number, you could say “Spell y-h-m-6-0-9.” Dragon would 
type yhm609. Say “Spell Cap-m-a-c-m-i-l-l-a-n-trademark” to 
get MacMillan™ in your document.

Spelling a word adds that word to the active vocabulary. Words 
that contain numbers are not added to the vocabulary.
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 To dictate unusual text such as automobile license plate numbers or 
product codes, you can also switch to Spell mode by saying “Switch To 
Spell Mode,” and then dictate letters.

You can make the Spell dialog box appear whenever you use the 
Spell command by setting the “Spell” commands bring up the Spell 
dialog box option on the Correction tab in the Options dialog box. 
See the online help for more information.

You can also access the Spell dialog box when using the Select or 
Correct commands.

For a list of how to spell special characters, see the Spelling topic 
in the online Help.

Playing back your dictation

Playback commands work in the DragonPad, Microsoft Word 
(Versions 97, 2000, 2002, 2003, and 2007), Corel WordPerfect 
(Versions 8, 9, 10, and 12), and Lotus Notes.

Although Dragon never makes a spelling mistake, the mistakes 
it does make can be challenging to find and fix. Sometimes, what 
the program types looks very different from what you actually 
said.

To make correcting mistakes easier, Dragon records your voice 
as you dictate. You can play back your voice whenever you 
cannot tell by looking at your document what you originally 
said.

 Unless you have Dragon Professional or a higher edition, 
playback is available only until you close a document. After you close a 
document, Dragon deletes the recorded dictation for that document. 
See page 88 for information on saving dictation for later correction 
(Professional and higher editions).

Playing back dictation from the Correction menu
When you’re working in the Correction menu, click the Play 
Back button or say “Play That Back” to play the dictation that 
goes with the words you’re correcting. Then edit the text to 
match what you said.

TIP:

NOTE:
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You can set up Dragon to play back dictation automatically 
whenever you open the Correction menu. On the Dragon menu, 
select Tools > Options > Correction tab. On the Correction tab, 
select Automatic playback on correction.

Sometimes, there’s no dictation to play back. For example, you 
cannot play back text that wasn’t entered by voice, such as 
words you typed or pasted into your document. 

 Even when you have entered text by voice, you cannot play it 
back after you have cut it, copied it, pasted it, or otherwise moved it 
around in the document.

If you have Dragon Naturally Speaking Professional or a 
higher edition, you can save your dictation with your document 
for later playback (see Dictate now, correct later on page 88). 
Otherwise, you cannot play back dictation after closing a 
document. 

If dictation is not available, the Play Back button is dimmed 
(grayed out). When playback is not available, you may find text-
to-speech useful for checking your work. See Notes on 
correcting with another author’s user files on page 90.

Playing back dictation in a document
To help you check your work for mistakes, you can play back a 
line, a paragraph, a selection, or the whole document. After 
playback starts, you can stop it as soon as you notice a mistake 
and automatically open the Correction menu.

The Playback toolbar is an extra section of the DragonBar that is 
normally hidden. To see the Playback toolbar, click the double 
chevron icon on the DragonBar to open the Extras toolbar.

NOTE:

Start 
Playback

Stop
Playback Skip

Forward

Correction
Button

Skip
Back

Transcribe
Button

Read 
That
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To play back dictation:
To play back dictation, do any of the following:

■ Select the text you want to play back, and say “Play That 
Back.” 

■ Click the Start Playback button on the Playback toolbar. 

■ Move the insertion point to the text you want to play back and 
say any of the following commands:

To stop playback:
To stop playback, do any of the following:

■ Click the Stop Playback button on the Playback toolbar.

■ Click anywhere in the document window. 

■ Press the ESC key.

(It’s not possible to stop playback by voice, because the 
computer cannot hear speech input when it is playing back 
dictation.)

To skip backward or forward:
You can skip backward or forward in your document by a few 
words by clicking the Skip Backward and Skip Forward buttons. 

SAY TO

Play Back Line Play back dictation for the current line.

Play Back 
Paragraph

Play back dictation for the current 
paragraph.

Play Back Document Play back dictation for the whole 
document.

Play Back Window Play back dictation for the text in view.

Play Back to Here Play back dictation from the top of the 
document window to the insertion point.

Play Back from Here Play back dictation from the insertion 
point to the bottom of the document 
window.
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To stop playback and correct a mistake:
To stop playback and correct a mistake, do any of the following:

■ Click the Correction button on the Playback toolbar.

■ Press the minus (–) key on the numeric keypad. 

This stops playback and simultaneously opens the Correction 
menu. There you can correct the text for the last phrase played 
back.

 By default, Dragon stores about 30 minutes of dictation (40 MB). 
If you want to be able to store more dictation, you can change the 
amount of disk space that’s set aside for storing it. On the Tools menu, 
click Options, and then click the Data tab. Increase the number in the 
Disk space reserved for playback box.

Dictate now, correct later
When you dictate into the DragonPad, you can save your 
dictation with your text so either you or someone else can 
correct it later. You must create and edit your file in the 
DragonPad to be able to play back dictation. This feature is 
available in Dragon Professional and higher editions.

You can save dictation with your document if you select the 
Save recorded dictation with document box on the Data tab of the 
Options dialog. The first time you save a document in DragonPad 
during an editing session, Dragon asks you whether you want to 
save your speech data. If you save your speech data, you can 
reopen the document at a later time and play back your 
dictation. If you do not save your speech data, your dictation is 
stored only during the current editing session.

Correcting your own dictation
If you save your dictation, you can open your file later and play 
back and correct the text as if you had just dictated it.

Correcting someone else’s dictation
You can play back someone else’s dictation and correct the text 
to match the dictation. You can do this in two ways: 
■ Correct the dictation using your own user files. 
■ Correct the dictation using the document author’s user files. 

NOTE:



User Guide

89

Correcting with your own user files
You should use this correction technique if you regularly correct 
another person’s text by voice and it is not important to 
maximize the author’s recognition accuracy.

When you use your own user files to correct someone else’s text, 
you can correct the dictation just as you would correct your 
own dictation, using any combination of voice commands and 
keyboard typing. Even though you are correcting someone else’s 
dictation, your work won’t reduce recognition accuracy for 
either you or the person who dictated the text. But your 
corrections to the other person’s dictation won’t improve his or 
her recognition either.

Correcting with the document author’s user files
You should use this correction technique if you do not need to 
correct by voice and it is important to maximize the author’s 
recognition accuracy. 

 This technique works if all work is done on a single computer. 
Consult your Dragon reseller about ways to dictate on one computer 
and correct on another.

If you correct dictation using the author’s user files, you must 
not correct by voice, or you may reduce that person’s 
recognition accuracy. You can, however, improve the author’s 
recognition accuracy if you make corrections by using the 
keyboard and mouse with the Correction menu, as in the 
following procedure. 

To correct using someone else’s user files:
1 Make sure you are not wearing the microphone headset, or 

that the microphone is not turned on or plugged in. This 
action ensures that you don’t accidentally reduce the 
accuracy of someone else’s user files by using your voice. 

2 Be sure the DragonPad Extras toolbar is displayed so you can 
see the playback command buttons. 

3 Open the user files of the person whose text you will correct. 

4 In DragonPad, open the document to correct. 

TIP:
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5 Use the buttons on the Extras toolbar to play back dictation. 

6 Select the text you want to correct by mouse or keyboard. 

7 Press the correction hot key (normally the minus [–] key on 
the numeric key pad) or click the Correct button on the 
DragonBar Extras toolbar. The Correction menu appears with 
the selected text. 

8 Use the keyboard to correct the text. 

9 When you finish, save the text and the user’s speech files. 

 Notes on correcting with another author’s user files

This technique is effective if all work is done on a single computer. 
Consult your Dragon reseller about ways to dictate on one computer 
and correct on another. 

Display the DragonBar Extras toolbar by clicking the double 
chevron icon  on the DragonBar (not possible in Cling mode).

■In the Correction menu, you can use the mouse or keyboard to select 
any of the commands displayed below the correction choices. For 
example, you can click Spell That to open the Spell dialog box 
and spell the word. 

■You may want to select the following on the Correction tab of the 
Options dialog box: 

■Correct command brings up Correction menu 
■Automatic playback on correction box 

With these settings, Dragon automatically plays back the author’s 
dictation for each selection of text you correct. The Correction 
menu does not play back dictation.

■When you correct someone else’s dictation, be sure that the amount of 
disk space you have reserved for storing dictation is at least as large 
as the amount allocated for the user that created the text. You allocate 
the disk space on the Data tab of the Options dialog box. 

■Saving dictation with documents can take up more than a megabyte of 
disk space per minute of dictation. To save this space, delete any 
dictation audio you no longer need. 

■Dragon saves dictation audio in a file with the same name as the 
document, but with the .dra extension. For example, for a document 

NOTE:
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called MyDoc.rtf, Dragon saves your dictation in a file called 
MyDoc.dra in the same directory as your document. 

Using text-to-speech
You can use text-to-speech to have text displaying on your 
screen (not your current dictation) read aloud in a computer 
voice. You can use this feature to have the product read back a 
document that you (or someone else) dictated while you listen 
for mistakes and make note of sections you might want to 
revise.

Text-to-speech is available only in the DragonPad, Microsoft 
Word, and Corel WordPerfect. You can, however, copy and 
paste text from other programs and then use text-to-speech.

To start text-to-speech, do one of the following:
■ Select the text you want to hear (a line, a paragraph, and so 

on), and then say “Read That.”

■ Select the text you want to hear, and then select Read That 
from the Advanced submenu (or right-click in your document 
and click Read That from the shortcut menu).

■ Move the insertion point to the text you want to hear and say 
any of the following commands:

SAY TO

Read Line Read back the current line.

Read Paragraph Read back the current paragraph.

Read Document Read back the whole document.

Read Window Read back the text in view.

Read to Here Read back from the top of the docu-
ment window to the insertion point.

Read from Here Read back from the insertion point to 
the bottom of the document window.
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To stop text-to-speech, do one of the following:
■ From the NaturallySpeaking menu, point to Advanced and 

click Stop Playback/Reading.

■ Right-click in your document and click Stop Playback/Reading 
from the shortcut menu.

■ Press the ESC key.

You can control the speed, pitch, volume, and other text-to-
speech settings. From the menu, click Tools > Options and select 
the Text-to-Speech tab.
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6
Formatting

ou can bold text, change font sizes and styles, capitalize 
text, and apply other formatting by voice.

Many Dragon NaturallySpeaking formatting commands work 
for text that is selected (highlighted) in your document. To select 
text by voice, say “Selectjm” plus the words you want to select. 
See Selecting text by voice on page 75 for information.

 You can change the formatting properties of a word (such as 
whether Dragon should type a space before or after the word, or 
whether the word is capitalized in a title) by using the Word 
Properties dialog box. See the online help for more information.

Types of commands

Most of the commands listed in this chapter are global—they are 
available in virtually every application. In addition to the global 
commands listed here, Dragon includes many commands for 
editing and formatting that work in common applications. For 
more information on finding these commands see the online 
help.

Y

NOTE:
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Capitalizing text

Capitalizing first letter of next word you dictate 
Dragon capitalizes many words automatically, such as the first 
word in a sentence (following a period, question mark, or 
exclamation mark). It capitalizes the first word after you say 
“New Paragraph” (not when you say “New Line”) and it 
capitalizes proper names (when these words are already in the 
Dragon vocabulary in capitalized form).

 You can change the spacing and capitalization rules for a word 
in the Word Properties dialog box. See the online help for more 
information.

When you’re dictating, you can capitalize words that aren’t 
automatically capitalized by saying “Cap” and then the word. 
For example, say “Cap zelda” to get Zelda.

 If saying “Cap <word>” doesn’t work, try say “Cap Next 
<word>.”

 To dictate the word “cap,” for example, in this sentence: The 
company is putting a cap on salary increases, you must say 
“the company is putting a” then say “Spell c-a-p,” and then say “on 
salary increases.” In this way, Dragon knows that you do not want to 
capitalize any of the words within the sentence.

Capitalizing consecutive words 
When you want to capitalize consecutive words (for example, if 
you’re dictating a book title), you can turn capitals on and then 
turn them off when you’re finished. This is usually easier than 
saying “Cap” before each word. Another way to do consecutive 
capitalization is to dictate the words, pause, and then say 
“Capitalize That” or “Cap That.”

To capitalize the first letters of consecutive words:
1 Say “Caps On” to turn capitals on.

 When “Caps On” is active, Dragon uses title case. This means it 
capitalizes the first letters all words except for articles and prepositions 
(such as “the” and “to”).

NOTE:

TIP:

TIP:

NOTE:
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2 Dictate the words you want capitalized. For example, say: 
“success is a journey [colon] seven steps to achieving 
success in the business of life”

Dragon types: 

Success Is a Journey: Seven Steps to Achieving Success in 
the Business of Life

3 Say “Caps Off” to turn capitals off.

Dictating next word in all capital letters 
When you’re dictating, you can enter a word in all capital letters 
by saying “All Caps” and then the word. 

For example, say “All Caps please” to get PLEASE.

Dictating consecutive words in all capital letters 
When you want to dictate consecutive words in all capitals, you 
can turn all capitals on and then turn them off when you’ve 
finished.

To dictate consecutive words in all capitals:
1 Say “All Caps On” to turn all capitals on (like pressing the 

CAPS LOCK key).

2 Dictate the words that you want to appear in all caps. For 
example, say “the end” and Dragon types THE END

3 Say “All Caps Off” to turn all capitals off.

Dictating next word in all lowercase letters 
When you’re dictating, you can enter a word in all lowercase 
letters by saying “No Caps” and then the word.

For example, say “No Caps Jennifer” to get jennifer. (Dragon 
normally capitalizes this and other proper names.) 

Dictating consecutive words in all lowercase letters 
When you want to dictate consecutive words in lowercase 
letters (for example, names of computer files or e-mail 
addresses), you can turn the “no capitals” feature on and then 
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turn it off when you are finished. This is usually easier than 
saying “No Caps” before each word.

To dictate consecutive words in all lowercase letters:
1 Say “No Caps On” to turn no capitals on.

2 Dictate the words you want to appear in all lowercase.

3 Say “No Caps Off” to turn no capitals off.

Capitalizing (or uncapitalizing) text already in your 
document 

You can change the capitalization of text already in your 
document by selecting it and then saying “Capitalize That,” 
“Cap That,” or “All Caps That,” or “Uncapitalize That,” 
“Uncap That,” or “No Caps That.”

To capitalize or uncapitalize text:
1 Select the text you want to change.

2 Say “Capitalize That,” “Cap That,” or “All Caps That,” or 
“Uncapitalize That,” “Uncap That,” or “No Caps That.”

Formatting text
You can use voice commands to specify any combination of font 
name, size, and style, in that order. These commands change 
text you dictate from then on or text you have selected. 

To set a new style for text you are about to dictate, use the “Set 
Font” and “Set Size” commands. To change the style of text 
you have already selected, use the “Format That” command.

Changing the font as you dictate 
While dictating, you can change the font face, size, and style by 
saying “Set Font” followed by the font attributes you want. For 
example, you can say “Set Font Times” or “Set Font Arial 12 
Bold.” When you continue dictating, the new text appears with 
the font attributes you set.
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Changing font face

Changing font size
Say “Set Size” and then a size from 4 to 100 points. For 
example, say “Set Size 18.” Then, continue dictating.

Changing font style

Changing a combination of font face, size, and style
Say “Set Font” and then the attributes you want (listed in the 
previous sections). You can specify any combination of font 
face, size, and style, but you must specify these attributes in that 

SAY THEN

Set Font Arial

Courier

Courier New

Garamond

Helvetica

Palatino

Times

Times New Roman

SAY THEN

Set Font Bold 

Italics 

Bold Italics

Underline 

Strikeout

Plain or Plain Text or Normal or Regular
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order (font face, then size, then style). See the list of examples 
below:

■ “Set Font Arial” 

■ “Set Font Arial 12” or “Set Font Arial 12 Point” 

■ “Set Size 12 Bold” 

■ “Set Font Arial Bold” 

■ “Set Font Bold” 

 If you’re changing only the font size, use the “Set Size” 
commands, not the “Set Font” command.

Changing the font later
You can go back and change the font face, size, or style of text 
by selecting it and then using the “Format That” commands. 
“Format That” works on selected text with the same 
combinations of font face, size, and style as the “Set Font” 
commands (see the tables in the previous section.)

To change the font:
1 Select the text you want to change.

2 Say “Format That” and then the font attributes you want to 
apply as described in the previous section. For example, say 
“Format that Arial 18.”

Bold, italics, and underlining 
You can apply formatting to text in your document by selecting it 
and then saying “Bold That,” “Italicize That,” or “Underline 
That.” You can also say “Strikeout That.”

NOTE:
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To add bold, italics, and underlining:
1 Select the text you want to change.

2 Say “Bold That,” “Italicize That,” “Underline That,” or 
“Strikeout That.”

To remove formatting:
1 Select the text you want to change.

2 Say “Restore That” to remove formatting.

Aligning text
You can change how text is aligned by placing your insertion 
point in the text and saying “Center That,” “Left Align That,” 
or “Right Align That.”

To align text:
1 Move the insertion point to the text you want to align.

2 Say “Center That,” “Left Align That,” or “Right Align 
That.”

You can also use the following commands on selected text: 
“Format That Centered,” “Format That Left Aligned,” and 
“Format That Right Aligned.”

Bulleted text
To add bullets to text, place your insertion point in the text and 
say “Format that Bullet Style.” To remove bullets, say 
“Format that Bullet Style” again.
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7
Dictating Numbers, Punctuation, 
and Special Characters

his chapter describes how to dictate numbers, punctuation, 
Web addresses, and a few other special items. For complete 

information on this topic, see the online help.

 If Dragon is not formatting a word as you would like, you can 
change the formatting properties of the word by using the Word 
Properties dialog box. See the online help for more information.

Dictating numbers
In most cases you can dictate numbers, including postal codes, 
as you normally say them. Dragon will display either a numeral 
(“3”) or the word (“three”), based on the context. To force 
recognition of digits as numerals instead of text without using 
the Numbers Mode, say “Numeral” before you say the digit, for 
example, say “Numeral Three” to get 3. When dictating 
numbers:

■ You can use or omit the word and as part of a number. For 
example, say “one hundred fifty” instead of “one hundred 
and fifty” to get the number 150. 

■ You can use “oh” and “zero” interchangeably to get 0. 

■ If you want a comma in a four-digit number, you must speak it 
explicitly. Numbers with five or more digits automatically 
include commas, with the exception of US ZIP codes. 

■ For a decimal point, say “point.”

T
NOTE:



Dictating Numbers, Punctuation, and Special Characters

102

 If you want to dictate only numbers, you can switch to “Numbers 
Mode.” See Switching recognition modes on page 119 for more 
information.

TO ENTER SAY

1 one
numeral one

5 five
numeral five

17 seventeen

23 twenty three

179 one hundred seventy nine
one seventy nine

5423 five thousand four hundred and twenty three

5,423 five [comma] four twenty three

12,537 twelve thousand five hundred and thirty seven

142,015 one hundred and forty two thousand and fifteen

35.23 thirty five [point] two three

0.03 All Dialects: zero [point] zero three 
Outside US/Canada: nought [point] nought 
three

43.28% forty three [point] twenty eight [percent sign]

02460 oh two four six zero

02460-1458 oh two four six zero [hyphen] one four five eight

2 3/4 two and three fourths

11/32 eleven over thirty two

$99.50 ninety nine dollars and fifty cents

45.35 45 Euros and thirty-five cents

£120.35 pound sterling sign one hundred and twenty 
point thirty five [All Dialects]

TIP:
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 If you are having problems dictating numbers, currency, times, 
or dates, make sure that your Regional Settings match the language 
(dialect) you selected when you created your user. 

Using Numbers mode
Any time you need to dictate a series of numbers and do not 
want Dragon to recognize them as words, you can turn on 
Numbers Mode. This could be useful, for example, if you are 
dictating in a spreadsheet program, such as Microsoft® Excel®.

To turn on Numbers Mode, say “Start Numbers Mode” or 
“Numbers Mode On.” To turn off Numbers Mode, say, “Stop 
Numbers Mode” or “Numbers Mode Off” or “Switch to 
Normal Mode.”

For more information on Numbers Mode and more ways to 
turn Numbers Mode on and off, see the section Switching 
recognition modes on page 119.

Dates 
You can dictate most dates the way you would normally say 
them. Say “oh” or “zero” to enter 0. In dialects other than US/
Canada, you can also say “nought.” 

See also Automatic formatting of dates, times, telephone 
numbers on page 106.

TO ENTER SAY

22 January 
1999

twenty two January nineteen ninety nine

April 9, 2001 April 9 [comma] two thousand and one

14/07/85 fourteen [slash] oh seven [slash] eighty five

3/11/02 three [slash] eleven [slash] zero two

3/11/2002 three [slash] eleven [slash] two thousand and 
two

April 1st April first

March 22nd March twenty second

the 1980s the nineteen eighties

NOTE:
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Times of day 
Dictate the time of day the way you would normally say it.

US/Canada: Dragon automatically types the colon (:) if you say 
“a m” or “p m” when dictating the time. Say “o’clock” or “colon 
zero zero” to enter 00.

 Dragon will recognize times more accurately if you say “numeric 
colon” instead of “colon” when dictating times.

Other Dialects: Dragon automatically types the point (.) if you say 
“a m” or “p m” when dictating the time, depending on the 
regional setting. Say “o’clock” or “point zero zero” to enter .00.

 The format of “a.m.” and “p.m.” depends on your computer’s 
regional Windows® settings.

See also Automatic formatting of dates, times, telephone 
numbers on page 106.

TO ENTER SAY

8:30 eight [colon] thirty or eight [numeric 
colon] thirty

7:45 AM seven forty five a m

10:22 PM ten twenty two p m

3:00 three o’clock or three [colon] zero zero

5:00 PM five o’clock p m

TO ENTER SAY

8.30 eight [point] thirty

7.45 AM seven forty five a m

10.22 PM ten twenty two p m

3.00 three o’clock

5.00 PM five o’clock p m

TIP:

NOTE:
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Telephone numbers 
North American phone numbers
Say US and Canadian phone numbers as you normally would, 
pausing briefly between each group of numbers.

You don’t need to dictate hyphens for most phone numbers 
(numbers that are 7, 10, or 11 digits long). Dragon will add them 
automatically. 

Telephone numbers outside North America
To dictate other phone numbers, including European phone 
numbers, you must say all the punctuation, including the 
hyphens, spaces, and parentheses.

TO ENTER SAY

965-5200 nine six five fifty two hundred

617-965-5200 six one seven nine six five fifty two oh oh

1-800-555-1212 one eight hundred five five five one two 
one two

(617) 965-5200 [open parenthesis] six one seven [close 
parenthesis] nine six five five two zero zero

1-212-555-1212 one two one two five five five one two one 
two 

TO ENTER SAY

(01628) 894150 [open parenthesis] oh one six two eight 
[close parenthesis] eight nine four one five 
oh

027 629 8944 oh two seven [space bar] six two nine 
[space bar] eight nine four four

61-7-4695-2055 six one [hyphen] seven [hyphen] four six 
nine five [hyphen] two zero five five

(65) 2778590 [open parenthesis] six five [close parenthe-
sis] two seven seven eight five nine zero
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 In dialects other than US/Canada, you can say “bracket” instead 
of “parenthesis.”

See also Automatic formatting of dates, times, telephone 
numbers on page 106.

Automatic formatting of dates, times, telephone numbers
To indicate how you want dates, times, telephone numbers, and 
other numbers automatically formatted:

1 On the DragonBar, select Tools > Auto-Formatting. The Auto-
Formatting dialog box appears.

2 Click the check box labeled Format Dates and select the 
format you want from its drop-down list. For instance, select 
Month D, YYYY or D/M/YY.

3 Click the check box labeled Format times. Dragon then 
formats times based on your Regional Settings in Windows. 

4 To have hyphens added to a phone number automatically, 
click the check box labeled Phone numbers (all other editions).

5 You can also click the check box for Prefer 5 million over 
5,000,000.

6 Other formats you can click check boxes for on this tab 
include United Kingdom and Canadian postal codes and 
several non-numeric formats that involve using common 
abbreviations, expanded contractions, abbreviations of units 
of measure and titles (such as Mr., Ms., Dr.), and formats for 
web and email addresses as well as street addresses.

7 If you have any edition, click OK to save the settings and 
close the dialog box. 

Fractions 
You can dictate most common fractions the way you would 
normally say them. To dictate 1/2, 1/3, 1/4, 1/5, 1/6, 1/7, 1/8, 1/9, 

TIP:



User Guide

107

1/10, and 1/16 or a multiple of these fractions, just say the 
fraction normally. 

If the denominator (bottom number in the fraction) is greater 
than 10, you can enter the fraction by saying “slash” or “over” 
between the two numbers.

A few common fractions can also be displayed on your 
computer as special characters (such as ¼, ½, or ¾) instead of 
two numbers separated by a slash character (such as 1/4, 1/2, or 
3/4). For information about dictating fraction characters, see 
Switching recognition modes on page 119.

Roman numerals 
You can dictate Roman numerals by saying “Roman numeral” 
and the number. For large numbers, say the number in small 
combinations (as in the examples shown here).

TO ENTER SAY

1/2 one half

1/4 one fourth or one quarter

15/16 fifteen sixteenths or fifteen over sixteen

3 7/8 three and seven eighths or three and seven over 
eight

TO ENTER SAY

9/12 nine [slash] twelve or nine over twelve

5 3/56 five [space bar] three [slash] fifty six

130/70 one thirty over seventy

TO ENTER SAY

I Roman Numeral one

IV Roman Numeral four

V Roman Numeral five

X Roman Numeral ten
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 Don’t pause after the word “Roman Numeral” when you’re 
dictating a Roman numeral. If you pause, Dragon may enter, for 
example, “Roman numeral three” instead of “III.”

Postal and ZIP Codes
Dragon can automatically formats postal codes. This feature is 
controlled from the Auto-Formatting tab of the Options dialog 
box. For more information, see the online help. 

US ZIP Codes
You can dictate US five-digit ZIP codes just as you dictate any 
group of numbers. When dictating nine-digit ZIP codes, you 
must say the hyphen.

UK and Canadian Postal Codes
You can dictate UK postcodes by saying “Postcode” followed by 
the letters and numbers that make up the postcode. For 
Canadian postal codes, say “Postal code” followed by the letters 

L Roman Numeral fifty

C Roman Numeral one hundred

D Roman Numeral five hundred

M Roman Numeral one thousand

XXIV Roman Numeral twenty our

XXXI Roman Numeral thirty one

MCMXCVII Roman Numeral one thousand
Roman Numeral nine hundred
Roman Numeral ninety
Roman Numeral seven

TO ENTER SAY

01886 oh one eight eight six

94704-1150 nine four seven oh four [hyphen] one 
one five oh

TO ENTER SAY

TIP:
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and numbers that make up the postal code. Spacing and 
formatting will happen automatically.

Currency and coin 
You dictate your own currency as you would normally say it.

Currency in US/Canada (US English dialect) 

Currency in Other Dialects (UK, Australian, Indian, 
and Southeast Asian English) 

TO ENTER SAY

NG3 2HX Postcode n g three two h x

E10 7BD Postcode e ten seven b d

EC2Y 4LK Postcode e c two y four l k

K1A 0M5 Postal code k one a zero m five

X0A 0H0 Postal code x oh a oh h oh

TO ENTER SAY

$58.00 fifty eight dollars and zero cents

$1.75 one dollar and seventy five cents

$5.25 five dollars and twenty five cents

$3.9 billion three point nine billion dollars

 45 forty five euros

 99.50 ninety-nine euros and five cents

£ 2.20 pound sterling sign two point two oh

£ 5 million pound sterling sign five million

TO ENTER SAY

$58.00 dollar sign fifty eight

$1.75 dollar sign one point seventy five

 4.25 four euros and twenty five cents
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 Dragon uses the currency symbol ($, £, and so on) specified in 
your Windows Regional Settings as your default currency.

Dictate other currencies by first saying the currency symbol 
followed by the digits.

US/Canada: If your Regional Settings are set to the United 
States or Canada, your default currency is $ (dollar). If you 
want to dictate a dollar currency amount, dictate it the way you 
normally do. If you want to dictate a pound sterling currency 
amount, say, for example, “pound sterling sign fifty eight” (to 
enter £ 58), and so on.

 In US/Canada, you must say “pound sterling sign” to enter £, 
since “pound sign” means # in the U.S. vocabulary. In all other dialects, 
you can say “pound sign” to type £.

Other Dialects: If your Regional Settings are set to the United 
Kingdom, your default currency is £ (pound sterling). If you 
want to dictate a pound sterling currency amount, dictate it the 
way you normally do. If you want to dictate a dollar currency 
amount, say, for example, “dollar sign fifty eight” (to enter 
$58) and so on.

 Australian users can say “fifty eight dollars” to dictate $58, 
since the Australian default currency is $ in Windows Regional Settings. 

 3.9 billion three point nine billion euros

£ 45 forty five pounds

£ 99.50 ninety nine pounds and fifty pence

£ 2.20 two pounds twenty

£ 5 million five million pounds

TO ENTER SAY

NOTE:

TIP:

NOTE:
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Punctuation

Using Natural Punctuation
Dragon can automatically add commas and periods at the 
appropriate places in your dictation without your having to 
explicitly speak that punctuation. This Natural Punctuation 
feature can be useful in helping you get used to dictation by 
focusing on what you are saying rather than how your speech is 
punctuated. 

Natural Punctuation only inserts periods and commas. You still 
have to dictate other punctuation marks. Even with Natural 
Punctuation turned on, you can still dictate periods and 
commas. As you become more adept at dictation and want more 
control over where punctuation appears, you may want to 
explicitly dictate all your punctuation.

For information on correcting punctuation, see Correcting 
Punctuation on page 74.

 Periods will only appear at the end of a sentence once you have 
started the next utterance or said “New Line” or “New Paragraph.”

Enabling and disabling automatic punctuation
Natural Punctuation is turned on by default.

There are two ways of turning Natural Punctuation on and off:

■ Select Auto-Formatting Options from the Tools menu of the 
DragonBar and click Automatically add commas and periods. 

■ By saying “autopunctuation on” and “autopunctuation off.” 
Turning Natural Punctuation on and off by voice sets the 
option above in the Auto-Formatting dialog box. If you disable 
Natural Punctuation by voice, it stays disabled until you 
enable it again.

TIP:
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Dictating Punctuation
You can enter the punctuation marks and symbols listed below 
in text you dictate. For a list of all punctuation marks, see the 
online help.

TO ENTER SAY

, comma

. period
dot
point

[each one has different spacing 
characteristics]

? question mark

! exclamation mark (All Dialects)
exclamation point (US/Canada)

“ open quote
close quote

‘ open single quote
close single quote

( open paren (US/Canada)
left paren (US/Canada)
left parenthesis (All Dialects)
open parenthesis (All Dialects)

) close paren (US/Canada)
right paren (US/Canada)
right parenthesis (All Dialects)
close parenthesis (All Dialects)

‘ apostrophe

‘s apostrophe-ess

- hyphen
minus sign

-- [double hyphen] dash

space bar
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You can use the Vocabulary Editor to view or change the 
formatting properties of the punctuation. 

Words that end with ’s
To dictate a word ending with apostrophe S (’s), just say it as 
you normally would. Dragon will often add it. If Dragon doesn’t 
include the ’s, you can add it later.

Including ’s as you dictate
When you want to make sure that Dragon types a word with ’s, 
say “apostrophe ess” after saying the word. For words that 
already end in “s,” say “apostrophe” after the word, as in the 
second example shown here. 

 You can add ‘s to a word by selecting it and then saying it again 
with “apostrophe ess.“

Dictating hyphenated words 
Many hyphenated words and phrases are already in the Dragon 
vocabulary. To dictate a word or phrase that is usually 
hyphenated, just say it as you normally would.

TO ENTER SAY

We took Mary’s car We took Mary’s car

that’s enough that’s enough

it’s time to go it’s time to go

TO ENTER SAY

We took my brother’s 
car

We took my brother [apostro-
phe ess] car

I met my friends’ 
children

I met my friends [apostrophe] 
children

TO ENTER SAY

long-lasting long lasting

up-to-date schedule up to date schedule

TIP:
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Including hyphens as you dictate 
To hyphenate words that Dragon doesn’t hyphenate 
automatically, just say “hyphen” wherever you want a hyphen.  

You can hyphenate words you just dictated with the command 
“Hyphenate That.” Select the words you want to hyphenate 
and say “Hyphenate That.” If you say this command when no 
words are selected, Dragon will usually hyphenate the last few 
words that you said.

Removing hyphens 
You can remove a hyphen by selecting it and replacing it with a 
space. 

To remove a hyphen:
1 Say “Select hyphen.”

2 Say “Space Bar.”

Preventing hyphens 
You can prevent Dragon from entering a hyphen by pausing 
where the hyphen would normally be.

For example, to type “long lasting” (normally hyphenated) say 
“long,” then pause for a moment, and then say “lasting.” Or 

Tokyo-based company Tokyo based company

nine-year-old boy nine year old boy

TO ENTER SAY

speech-recognition 
software

speech [hyphen] recognition software

power-sharing 
agreement

power [hyphen] sharing agreement

Elizabeth Walker-Smith Elizabeth Walker [hyphen] Smith

TO ENTER SAY
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you can say “long space bar lasting” without pausing, to insert 
a space in place of the hyphen.

Dictating compound words 
Dragon joins compound words (such as “note” and “book” to 
form “notebook”) automatically, based on standard usage. To 
dictate a compound word, just say it as you normally would. 

Compounding words as you dictate 
To compound words that Dragon doesn’t join automatically, just 
say “No Space” between the words.

You can also dictate consecutive words without spaces by 
turning No spaces on and then turning them off when you’ve 
finished.

To dictate consecutive words without spaces:
1 Say “No Space On” to turn spaces off.

2 Dictate the words you want to appear without spaces.

3 Say “No Space Off” to turn spacing back on.

Compounding words later 
You can compound the last words you said or compound 
selected words by saying “Compound That.” This command 
removes all spaces between selected words. Or, if no words are 
selected, it removes all spaces in the last utterance. Any tabs or 
line breaks are also removed.

TO ENTER SAY

unitednations united [No Space] nations

WorldWide Web [Cap] world [No Space] [Cap] wide 
[Cap] web
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To compound words:
1 Select the text you want to join. For example, if you want to 

join the words “Web TV,” say “Select Web TV.”

2 Say “Compound That.”

Dictating names
Many names of people, places, and events are already in the 
Dragon vocabulary. For example, you can dictate “Martin 
Luther King,” “New York Times,” and “Boston.”

To dictate a name, first try dictating the name. Dragon 
automatically capitalizes the names it knows. If Dragon 
incorrectly types the name, correct it by keyboard or by voice 
(see Correcting and Editing on page 69). 

If the program continues to type a name incorrectly after you’ve 
corrected it several times, train the word individually using the 
Train Word dialog box. See the online help for more information.

Dictating abbreviations and acronyms 
Dragon knows many common abbreviations (such as NYC and 
BBC) and acronyms (such as NATO). To dictate an 
abbreviation or acronym, just say it as you normally would.

TO ENTER SAY

US/Canada: Dr. 
Other Dialects: Dr

Doctor

UK U K (say each letter)

RSVP R S V P (say each letter)

HTML H T M L (say each letter)

8 cm eight centimeters

US/Canada: pp. 27–33
Other Dialects: pp 27–33

pages 27 hyphen 33

NATO NATO (say as one word)

NASDAQ NASDAQ (say as one word)
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If Dragon types the full word instead of the abbreviation or 
acronym, enters the wrong word, or includes incorrect 
punctuation, just correct it in your document by voice or by 
keyboard.

Dictating e-mail and Web addresses
Dictate e-mail and Web addresses as you would normally say 
them. Dragon automatically formats them for you.

Here are some guidelines for dictating e-mail and Web 
addresses:

■ When you say “h t t p” or “w w w,” Dragon knows to format 
the next words you say as a Web address.

■ Say the following abbreviations by pronouncing them as 
words: 

“co,” “com,” “gov,” “mil,” “net,” and “org.”

■ Say the following abbreviations by saying each letter: 

“a c,” “b n,” “c a,” “e d u,” “ie,” “h k,” “i d,” “i n,” “j p,”
“m y,” “p h,” “s g,” “t h,” and “u k.” 

■ Use the “No Caps On” and “No Caps Off” commands to 
enter an e-mail or Web address in all lowercase letters. For 
more information about controlling capitalization, see 
Dictating consecutive words in all lowercase letters on page 
95.

TO ENTER SAY

Virginia@aol.com Virginia at a o l dot com

info@samplecom-
pany.com

[No Caps On] info at sample 
company dot com [No Caps 
Off]

http://
www.nuance.com

[No Caps On] h t t p w w w 
dot nuance dot com [No 
Caps Off]
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 You can create Text and Graphics custom commands for 
e-mail and Web addresses you use often. See the online help for more 
information.

Dictating special characters 

Dictating common special characters
The following special characters are in the Dragon vocabulary. 
To dictate these characters, just say their names.

TO ENTER SAY

& ampersand or and sign

* asterisk

@ at sign

` backquote

© copyright sign

^ caret

 ° degree sign

$ dollar sign or dollar

euros or euro sign

% percent sign

® registered sign

§ section sign

™ trademark sign

+ plus sign

- minus sign

« open euro quote

» close euro quote

# All Dialects: hash sign or sharp sign
US/Canada: number sign or pound sign

£ US/Canada: pound sterling sign
Other Dialects: pound sign or pound

TIP:
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For complete lists of special characters, see the online Help.

Switching recognition modes
Dragon lets you use different recognition modes in your 
dictation. Dragon uses normal mode by default. In normal mode, 
the program distinguishes between words, numbers, and 
commands. 

In addition to normal mode, there are other modes:

■ Numbers mode—The software recognizes only numbers, 
commands, and punctuation. If you are dictating only 
numbers (including currencies), working in this mode 
increases recognition accuracy.

■ Spell mode—The software recognizes only letters, numbers, 
commands, and punctuation. In Spell mode, Dragon allows 
you to say any combination of letters, digits, or symbols you 
might need dictate part numbers or license plate numbers. 
You can also say keystrokes such as space bar or backspace 
key. Spell mode is also useful for dictating internet or Web 
addresses.

■ Command mode—The software interprets everything you say 
as a command and nothing is interpreted as dictated text.

■ Dictation mode—The software interprets everything you say 
as dictation and nothing is interpreted as a command, except 
for a few commands such as “New Line” and “New 
Paragraph.”

:-) smiley face

:-( frowny face

;-) winky face

TO ENTER SAY
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To changes modes, you can:

1 Select the Words menu on the DragonBar and click the name 
of the mode you want. 

2 Switch modes by voice by saying one of these commands:

Turning a mode off by voice is the same as switching back to 
Normal mode.

 You cannot dictate fractions in Number mode.

MODE TO TURN ON, SAY TO TURN OFF, SAY

Numbers mode Numbers mode On 
or Start Numbers 
Mode or Switch to 
Numbers mode

Numbers mode Off or 
Stop Numbers mode 
or Switch to Normal 
mode

Spell mode Spell mode On or
Start Spell mode or 
Switch to Spell mode

Spell Mode Off or
Stop Spell Mode or
Switch to Normal 
mode

Command mode Command mode On 
or Start Command 
mode or Switch to 
Command mode

Command mode Off 
or Stop Command 
mode or Switch to 
Normal mode

Dictation mode Dictation mode On 
or Start Dictation 
mode or Switch to 
Dictation mode

Dictation mode Off or
Stop Dictation mode 
or Switch to Normal 
mode

NOTE:
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Index

A
abbreviations 116
acronyms 116
All Caps Off 95
All Caps On 95
All Caps That 96
All Caps [text] 95
American English 12
apostrophe ’s 113
applications

opening 47
starting (and utilities) 52
switching 48

Audio Setup Wizard 19
Australian English 12

B
BACKSPACE key 83
Bold That 98
British English 12
bulleted text 99
buttons, selecting 51

C
Cap That 96
Cap [word] 94
Capitalize That 96
Capitalize That 96
capitalizing text

already in a document 96
applying lowercase 95
consecutive words 94-95
next word 94

Caps Off 95
Caps On 94
Center That 99
characters

deleting 83
moving to next/previous 80
selecting 78

check boxes, selecting 51
clicking the mouse 65

Coexistence with previous versions 7
Command Mode 119
commas

automatically adding 111
Compound That 115
compound words 115
contractions. See apostrophe ’s
Copy That 81
copying text 81
Correct [text] Through [text] 2, 76
Correct [text] To [text] 2, 76
Correction menu 69
creating a new user 16
currency 109
Cut That 77, 81
cutting text 81

D
dates 103

setting automatic formatting 106
deferred correction 88
Delete That 82
deleting text

backing up and resuming dictation 81
characters 83
last words dictated 81
lines 82
paragraphs 82
specific words 77, 82-83

deselecting text 76
dialects

dictating currency 109
dictating times of day 104
spelling and punctuation conventions 2

dictate now, correct later 88
Dictation Box 35
Dictation Mode 119
dictation, saving for later playback 88
documents

moving to top/bottom 78
opening 47-48
selecting all text in 77
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dollar sign 109
Dragon Log 29
DragonBar 32, 40

Extras toolbar on 42
DragonPad 33

E
e-mail addresses, dictating 117
ESC key 87, 92
Extras toolbar 42, 90

F
folders

opening 52
folders, opening 47-48
fonts, changing 96
Format That 98
Format That Centered 99
Format That Left Aligned 99
Format That Right Aligned 99
formatting text 96

applying bold 98
applying italics 98
applying underlining 98
changing font face, size, and style 96
removing formatting 99

fractions 106

G
Give Me Help 36
Go to Beginning of Line 79
Go to Bottom 78
Go to End of Line 79
Go to Sleep 32
Go to Top 78

H
help

online 36
homophones, tips for selecting 75-76
Hyphenate That 114
hyphenated words 113

dictating 114

hyphens 114
preventing 114
removing 114

I
icons, selecting 54
Indian English 12
Insert After [text] 79
Insert Before [text] 79
installation 7
International Communications Alphabet 58
Internet addresses 117
introduction 1
Italicize That 98
italics, adding or removing 98

K
keyboard shortcuts

stopping playback 87-88, 92
keyboard, pressing keys 58-62

L
Left Align That 99
lines

deleting 82
moving to beginning/end of 79
moving up/down 80
selecting 77

list boxes 57
lowercase, applying 95

M
making selections

list boxes 57
measurements. See abbreviations
menus, opening and closing 50
microphone

plugging in 5
proper positioning 19
sleep mode 32
turning on and off 32

minus (-) key 88
modes 119
money 109
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mouse
clicking 65
moving the pointer 63-64, 66

MouseGrid 63
Move to Bottom 78
Move to Top 78
moving around a document

before/after specific words 79
to beginning/end of line 79
by paragraphs or lines 80
scrolling 57
to top/bottom of page 78
by words or characters 80

N
names

dictating 116
Natural Punctuation 33, 111
navigating

between windows 53
new user, creating 16
No Caps Off 96, 117
No Caps On 96, 117
No Caps That 96
No Caps [text] 95
No Space 115
No Space Off 115
No Space On 115
numbers 101

currency 102, 109
dates 103
fractions 106
Roman numerals 107
setting formats 15
telephone numbers 105
times of day 104

Numbers Mode 103

O
opening

folders 47
opening applications 47
options, selecting 51

P
Page Down 78
Page Up 78
pages. See moving around a document
paragraphs

deleting 82
moving up/down 80
selecting 77

Paste That 81
pasting text 81
periods

automatically adding 111
phone numbers 105

see Telephone Numbers
Play That Back 87
playback controls 85
playing back dictation 85

correcting mistakes 88
in the Correction dialog box 85
in a document 86
skipping backward 87
skipping forward 87
stopping 87-88
storage space for 88

possessives. See apostrophe ’s
postal and ZIP codes 108
pound sterling 109
problems dictating currency or time 103
programs, opening. See opening applications
proper names, dictating 116
punctuation 33, 111

automatic 111

Q
QuickStart 44

R
Read That 91
Regional Settings control panel 103
Restore That 99
Resume With 81
revising text. See Select-and-Say
Right Align That 99
Roman numerals 107
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S
’s 113
saving dictation 88

storage space for 90
Scratch That 77, 81
scrolling 57
searching while selecting 75
Select Again 75
Select All 77
Select Document 77
Select [text] 75
Select-and-Say
Select-and-Say Indicator 41
selecting text 75

again 75
characters 78
a document 77
lines 77
paragraphs 77
punctuation 75
specific words 76, 78

Set Font 96-97
Set Size 97
Setup Log 29
Skip Backward 87
Skip Forward 87
Skip Word button 22
sleeping 32
software installation 7
Southeast Asian English 12
speakers, plugging in 5
special characters 118
special folders

opening 52
Spell Mode 119
Spell That 70
Spell [text] 83
spelling

as you dictate 83
errors 85

starting applications. See opening
applications

Stop Listening 32
Strikeout That 98
student voice models 18

switching windows 48

T
Tab key 51
tabs (dialog box), selecting 51
teenage voices 18
telephone numbers 105

setting automatic formatting 106
text

see also Formatting Text
text-to-speech 91
times of day 104

setting automatic formatting 106
troubleshooting 40
typeface, changing 96

U
UK English 12
Uncapitalize 96
Uncapitalize That 96
Underline That 98
unselecting text 76
Upgrading 27, 30

directory structure 27
user files

creating 16
utilities

starting 52

W
Web addresses 117
What Can I Say 37
Windows

open special folders 52
windows

navigating between 53
switching between 48

words
deleting 77, 82-83
moving to next/previous 80
placing insertion point before/after 79
selecting 76, 78

Y
years 103
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Z
ZIP codes 108
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Information, Sales, Services and Technical Support

Please visit these sites:

■ http://support.nuance.com/

■ http://www.nuance.com/help/contact

The Nuance website gives access to many resources, including 
Frequently Asked Questions, usage tips, customer stories, 
Customer Service information, Technical Support content, and 
a detailed comparison between Dragon editions. 

It also lists Value-Added Resellers who provide training and 
customization services for Dragon, in person or remotely. These 
Nuance partners can help with individualized recommendations 
and coaching for special equipment, environments, workflows, 
goals, and needs; enlisting their services is particularly efficient 
for very busy users, very young users, users who are new to 
computers, and in case of issues with hearing, vision, mobility, 
or dyslexia, for instance. 

If you purchased your software from a Value-Added Reseller, 
contact them directly for technical support.

The Support area of the Nuance website offers a Knowledge 
Base of Tech Notes containing the latest technical information 
on the Dragon product family, including versions predating 
Version 11. It also includes documentation (User Guides, 
Reference Card…) and listings of microphones, digital voice 
recorders, tablet PCs, and other compatible hardware devices 
tested by Nuance and approved for use with Dragon.




